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Welcome

Welcome to QuickBooks. Whether you’ve been running your business for years or are just 
starting out, having an organised, ef" cient way to manage your business can save you time, 
money, and a lot of frustration.

Use this Startup and Quick Reference Guide to get up and running as fast as possible. In 
this guide, you’ll learn about:

• How to install QuickBooks and set up your company " le

• Important QuickBooks terms and concepts

• How to get around in QuickBooks

• Where to look for help when you have questions

• How to perform common tasks

• New features for QuickBooks 2008

Note: Since this guide covers multiple editions of QuickBooks, the name “QuickBooks” is used to refer to 

any of these editions. When information in this guide applies to a specifi c edition of QuickBooks, the specifi c 

edition name will be used.
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Installing and Setting Up QuickBooks

Hardware and software requirements

Processor, memory, and disk space

• 1 GB of disk space (additional space required for data " les)

When using Windows 2000/XP:

• At least 500 MHz Intel Pentium III (1.8 GHz Intel Pentium 4 recommended) or equivalent 
computer

• At least 256 MB (512 MB recommended) of RAM for a single user

• At least 512 MB of RAM for multiple, concurrent users

When using Microsoft® Vista™:

• At least 1.2 GHz Intel Pentium III or equivalent computer

• At least 1 GB of RAM

Disk space requirements for additional software

• 70 MB for Microsoft® Internet Explorer 6.0, provided on QuickBooks CD

• 150 MB for Microsoft .NET Framework CLR 1.1, provided on QuickBooks CD

• 9 MB for QuickBooks Timer

Additional hardware and software

• Microsoft® Vista™, Windows XP (Windows XP Professional with SP2 or later 
recommended), or Windows 2000 SP3 or later (SP4 or later recommended) operating 
system

• 2x CD-ROM drive

• Minimum of 1024x768 screen resolution

Integration/compatibility requirements

QuickBooks is compatible with these products, which are sold separately.

• If you plan to use features that integrate with Microsoft® Word or Microsoft Excel (such 
as for preparing letters or for importing and exporting QuickBooks data and reports), you 
need Microsoft Word 2000, 2002, 2003, or 2007, or Microsoft Excel 2000, 2002, 2003, 
or 2007. (More RAM enhances the use of these features.)

• If you want to synchronise with contact management software, you need Microsoft Outlook 
2000, 2002, 2003, or 2007. Contact synchronisation with Outlook requires QuickBooks 
Contact Sync for Outlook (downloadable for free from www.quickbooks.com/contact_sync).

• Business Planner functionality requires Adobe Reader 5.0, 6.0, or 7.0.

• QuickBooks Payroll subscriptions and online features/services require Internet access 
with at least a 56 Kbps connection speed (DSL or Cable Modem recommended).
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Installing QuickBooks

Firewall and antivirus software compatibility 

If you use " rewall or antivirus software, QuickBooks 2008 has been tested with the following 
products.

• Microsoft Windows XP SP2 built-in " rewall 

• Symantec Norton® AntiVirus, Internet Security Suite

• McAfee Anti-Virus 

• Trend PC-Cillin 

• Zone Labs ZoneAlarm

In some cases it might be necessary to adjust settings in these products to ensure the best 
possible performance with QuickBooks. Go to www.quickbooks.com/support/install.html for 
the latest information from Intuit.

Using ! rewall software on a network

If " rewall software is running while you install QuickBooks, you may be asked if you want to 
allow QuickBooks components to have access to the network. For QuickBooks to operate 
properly (especially in a multi-user environment) these components (QBDBMgrN.exe, QBW32.

exe, QBLaunch.exe, and QBUpdate.exe) must be allowed to access the network.

Different " rewall software applications use different terminology when prompting you. Be 
sure to choose an option that does not block connections to QuickBooks components. Also, 
some " rewall and antivirus software can affect QuickBooks performance. If you experience 
performance issues you think are related to your " rewall software, refer to the " rewall 
documentation or contact your " rewall supplier for assistance.

Multi-user installation requirements

QuickBooks lets you give up to " ve users access to QuickBooks " les on a network at the 
same time. For other users to work in the company " le, the company " le must be stored 
on a computer on your network, and you need to complete some additional installation 
and setup steps on the computer where the company " le is stored. Refer to “Installing and 
setting up QuickBooks for a multi-user environment” on page 12.

In a multi-user environment, QuickBooks (or the QuickBooks Server) should be installed 
on the computer on which the company " le is stored. Each user must have a QuickBooks 
license and must:

• Install the same version year of QuickBooks. For example, all users must have 
QuickBooks 2008.

• Have read/write access and create/delete rights to the directory where the company " le 
is stored.

• Have a valid License Number and Product Number. For a multi-user license pack, use the 
numbers from the pack.
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Note: The number of users who can access the company fi le at the same time is not necessarily equal to 

the number of licenses you purchase. For example, if you purchase a 5-User Value Pack and an additional 

license for the sixth person in your offi ce, only 5 of the 6 users can access the fi le at the same time.

For network hosting setup

To run QuickBooks in a network hosting environment, you must have Windows 2000, XP, or 
Microsoft Vista installed.

In a network hosting environment, each computer has its own copy of QuickBooks installed; 
however, the QuickBooks company " le is located on only one computer, which must be 
turned on and available on the network. Networks set up for hosting " les do not use a 
dedicated " le server, so a single, dedicated computer is not required to share " les. Thus, all 
the networked computers have the option to share their resources.

For example, you might run your small business by using QuickBooks on two computers—
yours and one that’s used by an employee. In this case, you still need to set up a simple 
network to share your company " le. Otherwise, you’ll need to make a backup of your 
company " le to move it or e-mail it between the two computers.

Note: Windows XP users must have at least Standard user rights and Windows 2000 users must have Power 

Users Group rights to write to the registry keys and be able to run QuickBooks.

For dedicated server setup

To run QuickBooks in a network environment with a dedicated server, you must have 
Windows 2000, Windows 2000 Server, Windows 2003 Server, Windows XP Professional, 
Windows XP Home Edition (not recommended) or Microsoft Vista.

Networks with a dedicated server have at least one computer (the server) dedicated to 
sharing " les, printers, or other resources. You should store your company " le on the server.

To run a dedicated server, a Microsoft Windows 2000 or later operating system is 
recommended. See “Additional hardware and software” on page 4 for Windows Service Pack 
recommendations). 
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Installing QuickBooks
QuickBooks provides three different installation options: Standard, Multi-user Host, and 
Server. Refer to the table below to choose the installation option that’s right for you and 
then follow the appropriate instructions on the following pages.

Note: If you previously installed QuickBooks from a trial CD, download, or some other mechanism, you 

might have chosen to receive a “Reinstall Pack.” The Reinstall Pack includes a QuickBooks CD and this 

documentation. You do not need to reinstall QuickBooks unless you are moving QuickBooks to another 

computer or replacing the installation on your current computer. Keep the reinstallation disk as a backup for 

later use.

Figure 1 on the next page illustrates the various ways the different installation options can 
be con" gured on your computer(s). 

Note: If you work in a multi-user environment, you might need to choose different installation options on 

each computer.

Choosing the correct QuickBooks installation option

Installation Type When to Use Refer to 

Standard
(most common)

•  If you are a single user (the only person in your 
company running QuickBooks) and not accessing the 
company " le from another computer on a network.

or
•   If you run QuickBooks on a network and access 

the company " le from another computer. (No other 
QuickBooks users will access a company " le from this 
computer.)

Page 9
(new users)

Page 9
(upgraders)

Multi-user Host

•   If you are working in a multi-user environment on 
a network, and this computer stores (hosts) the 
company " le that other users will access from their 
computers.

or
•   If you are running QuickBooks in a home of" ce, where 

you run QuickBooks on two computers (perhaps 
a desktop and a laptop), but this computer stores 
(hosts) the company " le that will be accessed by both 
computers.

Page 12

Server

•    If you are working in a multi-user environment on a 
network, and this computer stores the company " le 
that other QuickBooks users will access, but no one 
will actually run QuickBooks on this computer. (This 
computer simply acts as a " le server.)

Page 12
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Company
File Server

Installation

Company
File

Standard
Installation

One QuickBooks user, no networkOne QuickBooks 

Standard
Installation

Standard
Installation

Multi-user
Host Installation

One QuickBooks user, using network hosting (home office)

Company
File

pany
e

Multi-user
Host Installation

Multiple QuickBooks users, using network hosting

Standard
Installation

Multiple QuickBooks users, using a dedicated server on a network

Figure 1. Sample QuickBooks con! gurations and which installation option to use on each 
computer

The installation instructions on the following pages assume that you know which installation 
option you want and tell you to skip the Installation Interview. However, if you are still not 
sure which installation option to use, do not skip the Installation Interview, as it will guide 
you and help you choose the appropriate installation for each computer on which you want 
to install QuickBooks.
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Note: Based on the installation type, each computer is confi gured to 

either “host” company fi les or not. If you need to change this setting 

after installation, refer to the in-product Help. Search for “hosting” to 

fi nd related topics.

Standard installation and setup for new users

To install and start QuickBooks:

➊ Shut down all running programs, including antivirus 
programs.

➋ Insert the QuickBooks CD in your computer’s CD-ROM 
drive.

Note: If the Installation Wizard does not start automatically, click 

Start in the taskbar, then click Run. Type D:\setup.exe (where 

“D” is the CD-ROM drive letter). Click OK.

➌ In the Welcome to QuickBooks Installation window, click 
Expert Install.

➍ In the Installation Options window, click the Standard 
Installation option and then click Begin Installation.

➎ Follow the onscreen instructions.

➏ To start QuickBooks, double-click the QuickBooks icon 
 on the desktop or click the Windows Start button and 

then click QuickBooks from the Programs group.

Creating your company ! le

The " rst time you use QuickBooks, the EasyStep Interview 
window is displayed. The EasyStep Interview asks 
you questions about your business and then uses the 
information you provide to create your company " le. For 
detailed information about creating your company " le and 
setting up your company in QuickBooks, see “Setting Up 
Your Company in QuickBooks” on page 18.

Standard installation and setup for existing users 
(upgraders)

If you own a previous version of QuickBooks and are 
upgrading to QuickBooks 2008, you must " rst install the 
new program and then update your company " le. 

To install QuickBooks:

➊ Shut down all running programs, including antivirus 
programs.

Back up your previous 

accounting system

If you have an existing 

business, make sure 

that you’ve backed up 

your " nancial records 

from your previous 

accounting system. HMRC 

requires you to keep this 

information for six years. 

You should also keep any 

software and hardware 

that your previous 

accounting system used, 

or have printouts of all the 

information and accounting 

reports.

Troubleshoot error 

messages

If you receive an 

error message during 

installation, and rebooting 

your system does not 

resolve the problem, 

you can search for the 

error message on the 

QuickBooks support site at 

www.quickbooks.co.uk.

Did You Know?

9
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➋ Insert the QuickBooks CD in your computer’s CD-ROM drive.

Note: If the Installation Wizard does not start automatically, click Start in the taskbar and then click 

Run. Type D:\setup.exe (where “D” is the CD-ROM drive letter). Click OK.

➌ In the Welcome to QuickBooks Installation window, click Expert Install.

➍ In the Installation Options window, click Standard Installation and then click Begin Installation.

➎ Follow the onscreen instructions.

➏ After installation, the File Management Tool might instruct you to move your company 
files or to perform some additional installation modifications. Follow the onscreen 
instructions.

Note: We recommend that you keep your old version of QuickBooks installed. You may need it to 

perform operations on your old company fi le.

➐ To start QuickBooks, double-click the QuickBooks icon  on the desktop or click the 
Windows Start button and then click QuickBooks from the Programs group.

Updating your company ! le

This section describes how to update a company " le created in a previous version of 
QuickBooks for Windows. Before you can update your company data, you must install the 
new version of QuickBooks as described above.

Note: Multicurrency is not supported in QuickBooks 2008. Company fi les with transactions that use 

multicurrency cannot be upgraded. If this affects your company fi les, contact Intuit Technical Support.

Back up your data before opening it in a new version of QuickBooks. You can back up to 
your hard drive or to a backup disk.

Caution After you update an existing company " le to QuickBooks 2008, do not 
delete your original " le. You may need it to generate VAT reports on transactions 
before this date.

To update your QuickBooks ! le:

Note: If you are updating a company fi le from QuickBooks 2003 or earlier, you will need to fi rst upgrade 

your company fi le with QuickBooks 2006. Call Intuit Technical Support for a free Upgrader’s Kit.

➊ In QuickBooks 2008, open your existing company data file.

➋ When prompted to update your file, enter YES and click OK.

➌ Click Next and follow the onscreen instructions.

• When asked whether your company has " led a VAT return, Click Yes if you have—even 
if you " led outside of QuickBooks. Make sure you have a copy of your last return.

 Otherwise, click No.
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• When prompted to back up your company " le, choose the directory on your hard drive 
or the disk drive where you want to store your backup " le and click OK.

 Failing to back up your ! le might result in lost data if you encounter a problem during 
the update process. Do not overwrite existing backups with this upgrade backup.

• When prompted to move or rename your company " le, we recommend that you allow 

the utility to move your company " le from the Program Files folder to C:\Documents 
and Settings\All Users\(Shared) Documents\Intuit\QuickBooks\Company 

Files.

Note: The Windows Program Files folder is no longer a recommended location for storing company 

fi les. 

➍ When QuickBooks indicates that it is ready to upgrade your company file, click Finish. 
Depending on the size of your company file, the upgrade process may take up to an hour.

Note: Due to changes and improvements in the QuickBooks data fi le format, the size of your company 

fi le might signifi cantly increase after you update it.

If an update problem occurs

If you attempted to upgrade your " le and the update failed, you must perform steps in 
your older version of QuickBooks to " x the problem. If you removed your older version of 
QuickBooks, reinstall it to a new directory. Do not install the older version in the directory 
where you installed QuickBooks 2008.

To ! x a failed QuickBooks ! le update:

➊ Start the older version of QuickBooks.

➋ Open your old company file. If necessary, you can restore your company backup using the 
older version of QuickBooks. Go to the File menu, click Open or Restore Company, and 
then follow the onscreen instructions.

➌ Go to the Window menu and click Close All.

➍ Go to the File menu, click Utilities, and then click Rebuild Data.

Caution The Rebuild Utility forces you to create another backup. Use a new CD or 
" le name. Do not overwrite any existing backups.

➎ After the Rebuild is complete (which might take a long time depending on the size of your 
company file), exit the older version of QuickBooks.

➏ Start QuickBooks 2008.

➐ Go to the File menu and click Open or Restore Company.

❽ Select the appropriate directory and file name of the company data you just rebuilt and 
click OK. The update should take place normally. If you still experience update problems, 
contact Technical Support at 0845 606 2161 (outside the UK, +44 870 609 0601).
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Installing and setting up QuickBooks for a multi-user environment

There are two ways to set up QuickBooks to be used in a multi-user environment, which will 
allow up to " ve users to access your QuickBooks company " le at the same time.

• The Multi-user Host installation enables users on a network to share " les between their 
computers directly (there is no dedicated " le server).

• The Server installation enables you to place your QuickBooks company " le on a dedicated 
" le server where all users can access the " le.

For all installations, you must follow the “Completing Multi-user setup” instructions on page 13.

Note: If you are not sure which multi-user installation option to choose, the QuickBooks Installation Interview 

will help you determine the type of installation you need to run for each of your users’ computers. We 

recommend that you walk through the entire interview for the fi rst installation you perform. If you are sure 

of the installation option you want, follow the appropriate procedure.

Multi-user Host Installation:  For multi-user environments in which users access the company 
" le(s) on this computer from a remote computer. The user on this computer will also run 
QuickBooks.

➊ Make sure your computers are properly networked. Refer to your operating system’s 
documentation for more information. 

➋ Insert the QuickBooks CD in the CD-ROM drive of the computer on which the company 
file will be stored. 

➌ In the Welcome to QuickBooks Installation window, click I know which installation I want, 
so take me to Installation Options.

➍ In the Installation Options window, choose Multi-user Host Installation and then click 
Begin Installation. 

➎ Follow the onscreen instructions.

➏ After installation, you may be asked to move your company files or to perform some 
additional installation modifications. You can also scan your computer for company files 
that need to be shared. Follow the onscreen instructions.

➐ New users should proceed to setting up the company file as described in “Setting up 
Your Company in QuickBooks” on page 18. Upgraders should update their existing 
company file as described on page 10.

➑ For each additional user who will use QuickBooks on the network, follow the instructions 
above except choose Standard Installation instead.

Server Installation: For multi-user environments using a server to store the QuickBooks company 
" le(s). This computer stores the company " le, but no one runs QuickBooks on this computer.

➊ Make sure your computers are properly networked. Refer to your operating systems 
documentation for more information. 

➋ Insert the QuickBooks CD in your computer’s CD-ROM drive of your server.
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➌ In the Welcome to QuickBooks Installation window, click I 
know which installation I want, so take me to Installation 
Options.

➍ In the Installation Options window, choose Server 
Installation and then click Begin Installation. This will 
install the QuickBooks Database server components 
only; the QuickBooks application will not be installed.

➎ Follow the onscreen instructions.

➏ At the end of the server installation, the QuickBooks 
Database Server Manager will scan the server for 
company files.

➐ For each additional user who will use QuickBooks on the 
network, follow the instructions above except choose 
Standard Installation instead.

Hosting Multi-user access

The installation option you choose con" gures the hosting 
settings for each computer. If you need to change the 
hosting settings after installation, refer to the multi-user 
setup topics in the in-product Help. 

Note: If you cannot install QuickBooks or the QuickBooks Server on 

the computer where your company fi le is located, you will need to 

choose a computer to act as the “host.” On that computer, open each 

company fi le in multi-user mode to confi gure the alternate hosting 

settings. For detailed steps, see the in-product Help topics for using 

the “Alternate Setup” for multi-user mode.

Completing Multi-user setup 

After you install QuickBooks on each computer on your 
network and set up your company " le, you need to perform 
these additional tasks:

• Set up user names and passwords for each user. You will 
need to assign one user to be the Administrator who 
de" nes all other users’ access. Refer to the in-product Help 
for instructions on setting up user names and passwords. 

• Share the folder that contains your QuickBooks company ! le 
across your network. You can press F2 while in QuickBooks 
to locate your company " le. See your operating system’s 
documentation to learn more about sharing folders.

• Register each copy of QuickBooks, as described in 
“Registering QuickBooks” on page 17.

Installing from a server

If your QuickBooks CD is 

mounted on a server or a 

shared CD-ROM drive, you 

can install from the CD, but 

you cannot install from the 

CD to a remote computer.

Choosing where to store 

your company fi le in a 

multi-user environment

Choose a location for your 

company " le where all the 

computers that need to use 

QuickBooks can access 

the " le. You might want to 

put the company " le on the 

computer of the person 

who most frequently uses 

QuickBooks. This enables 

that person to have the 

fastest access to the 

company " le.

Improving performance in 

multi-user mode

To improve QuickBooks 

performance in multi-user 

mode, consider these tips:

• Store company " les 

on the fastest or most 

powerful computer, 

preferably a dedicated 

server.

• Run reports during off 

hours.

• Refresh reports only 

when you’re ready to use 

or print them.

• Avoid keeping 

unnecessary QuickBooks 

windows or other 

applications open.

Did You Know?

13
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• Turn on multi-user mode for each computer on your network.

➊  Go to the File menu and click Switch to Multi-user Mode.

➋ Click Yes.

Note: Based on the installation type, each computer is confi gured to either “host” company fi les or not. If 

you need to change this setting after installation, refer to the in-product Help. Search for “hosting” to fi nd 

related topics.

You may need to expand the number of people who work on QuickBooks in the future. Each 
additional user must have his or her own license. For more information, see “How do I 
purchase additional user licenses so I can add users to my QuickBooks?” on page 102.

Why are passwords important? 

Passwords limit access to your company " le. To open a password-protected " le, each person 
must enter his or her user name and a unique, case-sensitive password. De" ning users and 
passwords helps prevent unwanted people from accessing your company’s con" dential data.

We strongly recommend that you password-protect the Admin user. Otherwise, anyone who 
can access the company " le will have full access rights. By de" ning users and their access 
rights, you not only control who can open your company " le, but also what data they can 
view and tasks they can perform.

Troubleshooting installation problems

What should I do if I have trouble installing QuickBooks?

➊ Verify that your system meets the minimum system requirements, listed on page 4.

➋ Restart your computer.

➌ Close all open programs, including antivirus programs. Go to the Windows Task Manager 
(Task List), click the Applications tab, and close all open programs.

➍ Try installing QuickBooks again.

If you need further installation assistance, contact Customer Support at 0845 606 2161, 
Monday to Friday (9.00 a.m. – 5.30 p.m.), or if outside the UK, +44 870 609 0601). You can 
also visit the QuickBooks support web site at http://www.quickbooks.co.uk.

What should I do if I can’t ! nd my Registration Number? 

QuickBooks no longer uses registration numbers. The only numbers you’ll need are your 
Product and License numbers found on a sticker with your QuickBooks CD or by clicking 
“About QuickBooks” from the Help menu. (If you register your copy of QuickBooks by phone, 
you may also be given an Activation number.)
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Did You Know?
What should I do if I can’t ! nd my License Number or 
Product Number?

These numbers are located on your Intuit invoice or on your 
QuickBooks CD sleeve. If you no longer have these items 
but have QuickBooks installed on another computer, you can 
" nd your License Number and Product Number as follows:

➊ Start QuickBooks on the other computer and open a 
company file.

➋ Go to the Help menu and click About QuickBooks. Write 
down the numbers that appear on this screen. Use 
these numbers for the new installation.

If you are still unable to obtain your License Number and 
Product Number, you can call 0845 606 2161, or if outside 
the UK, +44 870 609 0601. Fees may apply.

Why doesn’t my old administrator password work after I 
upgrade?

QuickBooks 2004 and later releases support case-sensitive 
passwords. If you believe you are entering the correct 
password, but are still getting the message “The password 
you typed is incorrect.” Try the following:

• Attempt to log on by entering the login name of Admin and 
then click OK without typing a password.

• Enter your password with Caps Lock or Num Lock turned 
on or off.

• Enter password variations, using mixed upper- and lower-
case characters.

• Enter the password with a space before or after the actual 
password.

• Type the password in a text editor to con" rm that your 
keyboard is functioning properly.

• Restore a pre-update backup of your " le that does not 
have the case-sensitive password. When you restore this 
" le, you can set your new administrator password at the 
end of the update process.

If you are still unable to access your " le, contact Customer 
Support for assistance at 0845 606 2161 (outside the UK, 
+44 870 609 0601). A fee may be charged for this service 
depending on the support options of your service plan.

Record your password in a 

safe place

Be sure to write down and 

save your administrator 

password in a secure 

place. Passwords not only 

protect your company data, 

but are also required to 

access your company " le if 

you upgrade your version of 

QuickBooks. If you forget 

your password, see “What 

should I do if I forget my 

password” on page 106 for 

information.

Passwords are case 

sensitive

Keep in mind that 

passwords are case 

sensitive in QuickBooks 

2004 and later. When 

adding or editing a user 

password, check the Caps 

Lock and Num Lock keys. If 

you mistype the password, 

you will not be able to 

access the company data.

Product Information 

window

The Product Information 

window lists information 

about your software, 

including the number of 

entries you have in your 

lists, the size of your 

company " le, which version 

of QuickBooks you are 

running, and the location of 

your company " le. To open 

the Product Information 

window, press F2 on your 

keyboard.
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Can I install different versions of QuickBooks on the same computer?

Yes. You can install multiple versions of QuickBooks (for example QuickBooks 2008 and 
QuickBooks 2006) on the same computer. However, you cannot run two instances of 
QuickBooks on the same computer at the same time.

Can I revert to an earlier version of QuickBooks?

Yes. Uninstall the version of QuickBooks that you don’t want and then reinstall the earlier 
version of QuickBooks. Remember that you will not be able to open company " les that you 
have updated to QuickBooks 2008 in earlier versions of QuickBooks. You can, however, 
restore your pre-update backup if you choose to go back to a prior version of QuickBooks.

Can I install QuickBooks on more than one computer?

You can install QuickBooks on the computers used by a single person. For example, if you 
bought one copy of QuickBooks for your of" ce, you can install it on your home PC or laptop as 
well. This does not violate the software license agreement as long as you are the only person 
using QuickBooks on both computers. However, if multiple users will be accessing QuickBooks 
on multiple computers, then you must purchase an additional licensed copy for each user.

What if I do not have Internet Explorer on my computer?

To use QuickBooks, you must have Microsoft Internet Explorer 6.0 installed. If you do not 
have any version of Microsoft Internet Explorer on your system, the QuickBooks Installation 
Wizard will install it for you. If you have an earlier version of Microsoft Internet Explorer 
currently installed, the installer will replace it with Microsoft Internet Explorer 6.0.

Note: Installing Microsoft Internet Explorer 6.0 will not affect the settings or preferences of other browsers 

on your system.

What should I do if I get an error message during installation?

If you receive an error message during installation and rebooting your system does not 
resolve the problem, go to the QuickBooks Support Web site (www.quickbooks.com/
support/install.html) to " nd solutions for common errors.

What should I do if I get an error message when updating my company ! le?

If you receive an error message when updating your company " le from a earlier version of 
QuickBooks, refer to the information in “If an update problem occurs” on page 11. You can 
also visit the QuickBooks Frequently Asked Questions web site and search the Knowledge 
Base for information about error messages.
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Registering QuickBooks
You can use QuickBooks up to 10 times without registering. After 10 sessions, you must 
register QuickBooks. Registration entitles you to many bene" ts including access to your 30 
days of free unlimited support included with QuickBooks 20081.

Go to the Help menu and click Register QuickBooks. You can also register by phone at 
0845 606 2161 (within the UK) or +44 870 609 0601 (outside the UK), Monday to Friday 
from 9.00 a.m. to 5.30 p.m. 

If you add additional users to your license, you can update your license information by going 
to the Help menu, clicking Manage My License, and then clicking Sync License Data Online.

Note: If you choose to install QuickBooks on a second computer, or if you need to move your installation to 

another computer, you will need to re-register QuickBooks.

Getting the latest updates to QuickBooks
From time to time, Intuit provides updates to QuickBooks that can be downloaded from the 
Internet. These updates might include new features, services, maintenance " xes, or new 
Help information. You can choose to update QuickBooks automatically or manually.

For a complete description of and instructions for the different update options, including how 
to share updates in a multi-user environment, refer to the in-product Help.

Converting data from other applications
If you are converting " nancial data from another application (such as Excel), refer to the 
instructions below for the appropriate application.

Excel

Detailed instructions about importing Excel® (.xls) and .csv data into your QuickBooks 
company " le are provided in the QuickBooks in-product Help. Importing data from Excel and 
.csv " les is not dif" cult, but does require you to prepare the " le properly.

To view the ! le preparation and conversion instructions:

➊ Start QuickBooks. Go to the Help menu and click QuickBooks Help.

➋ Click the Search tab in the Help window.

➌ Click in the Search field and enter importing Excel data.

➍ Click About importing data from an Excel or CSV file.

Note: If your Excel fi le is ready to be converted, you can convert it. Go to the File menu, click Utilities, click 

Import, and then click Excel Files.

1.  30 consecutive days of QuickBooks 2008 support included from " rst-time registration. Offer valid 90 

days from software purchase. Additional terms and conditions apply.

17
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Setting Up Your Company in QuickBooks
The " rst thing you need to do in QuickBooks is create a company fi le for your business. 
Setting up your company " le properly is the most important thing you can do to have 
QuickBooks help you manage your business ef" ciently.

The setup process is easy with the EasyStep Interview and should take you about 15 minutes 
to complete. Then, depending on the complexity of your business, completing your company 
setup can take anywhere from a few minutes to a few hours. The amount of time varies 
based on how much detail you add about your accounts, customers, suppliers, employees, 
products, and services, as well as the number of historical transactions you want to enter.

When you set up your company " le, QuickBooks will prompt you for details about your 
company. Before you begin the setup process, gather the information shown in the Getting 
Started Checklist on page 18. Some of this information you’ll need for the EasyStep 
Interview; other information you will need as you begin to use QuickBooks.

Create your company ! le

After you have gathered the company information listed in the Getting Started Checklist on 
the next page, you can set up your business using the QuickBooks EasyStep Interview. (Not 
all of the information in the checklist is required for the EasyStep Interview; however, you will 
need this information as you use QuickBooks to run your business.) The EasyStep Interview 
walks you through the setup procedure and helps you tailor QuickBooks for your business.

Getting Started Checklist

Company name
and address

You’ll need both the trading and legal name for your company. The legal 
company name is the name you use when " ling taxes for your business. 
The trading company name is the name that you want to appear on invoices, 
statements, reports, etc. (This is your “Doing Business As” name.)

Start date QuickBooks uses a start date as the point at which you begin entering your 
business transactions. You must enter all historical transactions between 
your start date and today to ensure complete accounting records for your 
business. Many business owners base their accounting records on their 
" nancial year, so that they can see transactions for the entire year. If this is 
not important to you, you can choose a different starting point, such as oday 
or the " rst of the month, quarter, year, or VAT period.

The start date is the " rst day after which you have gathered all your 
information. For example, if your year end is 31 March 2007, your 
QuickBooks start date is 1 April 2007. You need all the information up to 
and including 31 March 2007.

VAT Registration 
Number

A VAT registration number that is issued to you by HM Revenue & Customs 
once you register for VAT.

VAT
information

You need to know the VAT scheme you are registered for: either the Accruals 
(Standard) VAT scheme or Cash VAT Accounting scheme. Check with your 
accountant if you are not sure. You will also need opening balance " gures 
including amount of VAT owed to (or owed to you by) HMRC.
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Getting Started Checklist

Bank 
statements,
credit card
accounts, and
outstanding
cheques

You’ll need the most recent bank statement for one of your bank accounts 
with a closing date that’s before your start date. The closing balance on 
this statement will be your opening balance for the bank account you create 
in QuickBooks, and then you’ll enter all the open transactions, and all the 
new transactions from the start date forward. Eventually, you will need to 
have your latest bank statement balances and any outstanding cheques, 
deposits, withdrawals, or charges for all of the accounts you want to set up 
and manage in QuickBooks, including credit cards, bank accounts, lines of 
credit, and loans.

Assets and 
Liabilities

You will need the balance of each loan your business owes (liabilities) such 
as a bank loan, hire purchase, or director’s loan; or is owed (assets). If you 
have stock, you need to know its value as of your start date.

PAYE Tax 
Reference No.

If you have employees to pay, you need to register with the HM Revenue 
& Customs (previously called Inland Revenue) and obtain a tax reference 
number. This number can be found on the yellow payslip booklets (P30BC) 
issued by HMRC.

PAYE Liability If you are operating payroll, you need to know how much PAYE income tax 
and National Insurance (NI) contributions you owe to HMRC as of your start 
date.

Payroll If you are using Payroll, you should gather the following information from 
your employees: company information; compensation, bene" ts, and 
miscellaneous additions and deductions; tax information; employee 
information; year-to-date history; and liability payment information.

Optional
information

Eventually, you will need to enter detailed information about your customers, 
suppliers, and employees, as well as the products and services you sell, the 
products that you hold in stock, and any additional assets.

 To create your company ! le:

➊ Start QuickBooks by double-clicking the QuickBooks icon  on the desktop or clicking 
the Windows Start button and then clicking QuickBooks from the Programs group.

➋ Click Create a new company file, or go to the File menu and click New Company.

➌ The Welcome screen for the EasyStep Interview opens. Click Start Interview.

Note: We recommend that you do not skip the interview process. The more information you enter with 

the EasyStep Interview, the more accurate your company fi le will be when you begin to use QuickBooks 

for your business.

However, if you are an experienced QuickBooks user and prefer to create your company fi le manually, 

you can skip the EasyStep Interview by clicking Skip Interview on the EasyStep Interview Welcome 

screen. You will be prompted to enter some basic company information and to save the company fi le.

➍ Follow the onscreen instructions and complete the interview.

19
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Completing your company setup

After you’ve created your company " le, you can begin using QuickBooks to run your 
business. But before you do, we recommend that you review the information in this section 
to make sure your company " le is properly set up and that your data is complete.

This section describes some additional tasks you might need to do as you begin using 
QuickBooks. Depending on how much information you entered during the EasyStep 
Interview, some of these tasks might not apply to you.

Enter your company information

Do this task if you did not enter this information in the EasyStep Interview.

To enter the contact and legal information for your company, go to the Company menu 
and click Company Information. To learn more about each of the " elds and where the 
information you enter will be used in QuickBooks, click the Help button.

Review your Chart of Accounts

If you used the EasyStep Interview, a chart of accounts based on your type of business was 
set up for you. Review the chart of accounts to be sure it accurately re% ects the accounts 
you need to run your business. You can change account names and edit, delete, or add 
accounts as necessary. For example, you will need to add any personal bank, credit card, or 
loan accounts.

To view your Chart of Accounts, go to the Lists menu and click Chart of Accounts. 

Numbering your accounts

Some businesses prefer to organise their accounts by number. Adding numbers can help 
you identify the type of accounts, thereby speeding up your account selection on various 
forms. You might want to develop and follow a consistent account naming and numbering 
convention. For example:

 1000-1999 - Assets

 2000-2999 - Liabilities

 3000-3999 - Equity

 4000-4999 - Income

 5000-5999 - Cost of Goods Sold

 6000-6999 - Expenses

 7000-7999 - Other Income

 8000-8999 - Other Expense

If you want to use numbers to identify your accounts, you need to turn on this preference in 
QuickBooks, as follows. 

➊ Go to the Edit menu and click Preferences. 

➋ In the Preferences window, click Accounting in the list on the left. 
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➌ Click Company Preferences. 

➍ Select the Use account numbers checkbox. 

➎ Click OK.

Create your customer, supplier, and items lists

To bill customers and pay your bills with QuickBooks, you 
must update your customer, supplier, and item lists so that 
they accurately re% ect your business. Instructions for setting 
up these lists are provided in Chapter 4:

• “Adding Customers” on page 48

• “Adding Suppliers” on page 50

• “Adding Items” on page 52

You can choose to enter this information all at once, or 
you can enter it as you work, using the Quick Add feature, 
described on page 37.

Enter historical transactions

If your start date is before today’s date, you’ll need to enter 
past transactions from the start date to today. This ensures 
that your QuickBooks records are completely up-to-date and 
your reports will be accurate.

Enter historical transactions in chronological order. For 
example, QuickBooks won’t know how to credit a customer 
payment unless you’ve previously recorded the invoice to 
that customer. The most ef" cient way to enter historical 
transactions is in the account register.

Note: Entering historical transactions is especially important if 

customers don’t pay you at the time they receive goods or services. If 

you don’t enter historical transactions early on, it’s hard to track and 

collect late customer payments.

Intuit recommends that you enter your transactions in this 
order (verify with accountant):

• Invoices or statements you’ve sent out since your start 
date

• Purchase orders you’ve issued since your start date that 
you haven’t received in full

• Cash or cheques you’ve received since your start date

• Bills you’ve received since your start date

• Bills you’ve paid since your start date

Key Terms

Company fi le

The company " le is the 

data " le that QuickBooks 

uses to store and manage 

all the information and 

" nancial transactions for 

your business. QuickBooks 

company " les have the 

extension .qbw.

Historical transactions

A list of all business 

transactions as of a speci" c 

date. In QuickBooks, 

you can have many 

different lists of historical 

transactions, including:

• Estimates

• Invoices

• Sales receipts

• Customer payments

• Credit notes

• Purchase orders

• Item receipts

• Bills

• Payments to suppliers

• Credits with suppliers

• Journal entries

• Payroll transactions

E-mailing a company fi le

The QuickBooks portable 

company " le (*.qbm) is a 

compact version of your 

company " le. You can use 

the portable company " le 

to move the company " le 

to another computer or to 

e-mail the company " le to 

another person, such as 

your accountant.

To learn more about the 

portable company " le, refer 

to the in-product Help.
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• Deposits you’ve made to any of your accounts since your start date

• Any other cheques you’ve written (for things other than bills) since your start date

• Employee year-to-date information accrued from the beginning of the " nancial year through 
your start date

• Payroll liabilities owed at the time of your start date (for manual payroll and tracking 
payroll transactions only)

Note: If you don’t have time to enter all your historical transactions right away, don’t worry. You don’t need 

to enter all your past transactions before you start using QuickBooks for new transactions. Enter new 

transactions as they occur. Then catch up with historical transactions when you can. Remember, though, 

that your account balances will be incorrect (and your reports may be wrong) until you enter all the past 

transactions.

Note: If you subscribe to QuickBooks Payroll, you will add year-to-date payroll information while setting up 

payroll. For more details, see page 64.

Complete your bank account information

After you’ve entered your historical transactions, your account registers will contain entries 
re% ecting bills you’ve paid, cheques and payroll payments you’ve written, and deposits 
you’ve received. To make your account registers complete, you must also enter these 
transactions:

• Cheques or other charges that happened before your start date but didn’t appear on 
statements before your start date (i.e., didn’t clear)

• Other cheques you wrote after your start date that were not for bills or accounts payable 
(for example, credit card payments)

• Deposits you made after your start date that were not customer deposits

• Deposits you made before your start date but that didn’t appear on statements before 
your start date

• Bank charges and fees

• Interest paid on your account

Refer to the in-product Help for step-by-step instructions on how to enter these transactions 
to make your account registers accurate.

Synchronising with Microsoft Outlook

If you use Microsoft Outlook 98, 2000, 2002, 2003, or 2007, you can synchronise your 
contact manager with QuickBooks and transfer all your customer and supplier information 
(including address and phone) to QuickBooks.

Note: Intuit recommends synchronising your customer and supplier information before you enter any 

customers or suppliers manually.
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Did You Know?
To synchronise your customer and/or supplier information:

➊ Go to the Company menu, click Utilities, and then click 
Synchronise Contacts.

Note: If you are synchronising for the fi rst time, we recommend 

that you back up both the data in your contact manager and your 

QuickBooks company fi le before you synchronise.

Note: If you do not already have the QuickBooks Contact 

Synchronisation tool installed on your computer, you will be 

prompted to download and install it.

➋ Follow the onscreen instructions. You might be asked 
to resolve conflicts between your QuickBooks and 
contact manager data, assign uncategorised names 
to QuickBooks lists, or create alternative entries for 
duplicate names. If you need assistance with any of 
these tasks, click Help.

➌ When the Confirm Changes screen appears, review the 
list of changes and click Accept to apply the changes.

Enter any optional adjustments

After you’ve created your company " le, you might need to 
make a few adjustments as of your start date. Depending 
on your company, you might need to:

• Enter any VAT liabilities

• Adjust the Uncategorised Income and Uncategorised 
Expense accounts (for accrual basis only)

• Adjust for current income and expenses if your start date 
is not at the beginning of the " nancial year

• Distribute earnings and equity before your start date

Refer to the in-product Help for step-by-step instructions on 
how to enter these optional adjustments. If you are unsure 
whether you need to enter these optional adjustments, 
cheque with your accountant.

Key Terms

Assets

Company assets are the 

things that your company 

owns. QuickBooks 

distinguishes between two 

types of assets:

Current assets: Assets that 

you are likely to convert 

to cash within one year 

(such as the cash you 

have on hand, the money 

in your current and savings 

accounts, and the money 

your customers owe you).

Fixed assets: Assets 

that you do not expect 

to convert to cash within 

one year. A " xed asset is 

usually something you use 

to run your business (such 

as a truck, cash register, or 

computer).

Confi rming your opening 

balance when transferring 

data to QuickBooks

If you used an accounting 

program before using 

QuickBooks and you are 

now transferring data from 

that program to QuickBooks, 

make sure that the opening 

balance for your new bank 

account in QuickBooks 

is based on your bank 

statement and not the bank 

balance from your previous 

accounting software. 

The balance of the bank 

account from your previous 

accounting software will 

not include post-dated 

transactions or transactions 

that the bank has cleared.

Did You Know?
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Backing up your company ! le

The QuickBooks backup " le is a compressed version of your QuickBooks company " le that 
contains all transactions through the date the company backup was made. A backup " le 
provides insurance against accidental data loss and can be used to restore your data. 
QuickBooks backups have a .qbb extension and cannot be opened directly.

QuickBooks provides several backup options for securing your data:

• Standard backup

• Portable Company File

• Accountant’s Copy

To use one of the backup options, go to the File menu and click Save Copy or Backup.

To restore your backup, go to the File menu and click Open or Restore Company.

To learn more about backing up your company " le, refer to the in-product Help.

Next steps
After you’ve installed QuickBooks and set up your company " le as described in this chapter, 
you should:

• Learn how to use QuickBooks and get answers to your questions (see Chapter 3).

• Learn how to perform basic QuickBooks tasks (see Chapter 4).

• Learn about new QuickBooks features (see Chapter 5).
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Getting Around QuickBooks

The QuickBooks work area, shown in Figure 2, is designed to enable you to complete tasks 
quickly. QuickBooks provides several ways for you to work; choose the method that works 
best for you.

Figure 2. The QuickBooks work area

Using the Home page to move around in QuickBooks

When you open a company " le in QuickBooks, the Home page is displayed automatically. 
The QuickBooks Home page provides a big picture of how all your essential business tasks 
" t together. Tasks are organised into logical categories (Customers, Suppliers, Employees, 
Company, and Banking) with work% ow arrows to help you learn how tasks relate to each 
other and to help you decide what to do next.

Note: The workfl ow arrows indicate a logical progression of business tasks in QuickBooks. However, these 

arrows do not restrict you from doing tasks in a different order, or an order that works better for your 

business needs.

To start a task, simply click the icon for the task you want to do. For example, to create an 
invoice, click the Invoices icon.

To return to the Home page, click the Home button on the navigation bar.

The Home page offers quick
access to tasks and 
information related to major 
QuickBooks areas. The Home 
page provides a clickable !ow 

chart, account balances, and 

customization  options.

Refer to the in-product Help for 

detailed instructions about how 

to perform tasks in QuickBooks.

The navigation bar on the 

toolbar provides one-click

access to QuickBooks Centers

and the Home page.

The menu bar provides easy 

access to all QuickBooks 

tasks, features, and reporting 

functions.

The customizable icon bar 
on the toolbar provides one-

click access to the QuickBooks

features that you use most.

Flow chart icons include

informative tooltips to help you

learn QuickBooks and pick the

correct task.
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Did You Know?
The Home page also provides a quick glance about the 
state of your business. You can see your current account 
balances, updated automatically as you do work in 
QuickBooks, in the Account Balances list.  

The Home page you see has been customised to display 
only those tasks and features that you use, based on the 
questions you answer in the EasyStep Interview. Functions 
you don’t need won’t clutter your workspace. However, if 
you decide to use these functions later, you can always 
add them back to the Home page by clicking the Customise 
QuickBooks link in the Getting Started section of the Home 
page.

Finding your data in the QuickBooks Centres

QuickBooks includes Customer, Supplier, and Employee 
Centres where you can view and manage all of your 
customer, supplier, and employee information and 
transactions. You can go to one of the QuickBooks Centres 
by clicking the appropriate button in the navigation bar (on 
the left side of the toolbar).

Customer Centre

The Customer Centre, shown in Figure 3, is a lens into all 
your customer information. Without having to sift through 
multiple screens, you can view a list of all your customers 
and see pertinent information for each of them. Click on a 
customer’s name and you’ll immediately see all the activity 
you’ve had with them as well as their pertinent contact 
information (phone number, fax number, and payment 
terms). 

You can use the Customer Centre to " nd out how much 
money a speci" c customer owes you or to view a list of all 
your customers with open balances. You can also look at 
all your customer transactions (estimates, sales orders, 
invoices, credit notes, refunds, etc.) across all of your 
customers in the Transactions list rather than having to run 
separate reports.

Customising the desktop

You can modify the way 

that the QuickBooks 

desktop behaves and 

looks to suit your working 

style. To modify the 

QuickBooks desktop, go 

to the Edit menu and click 

Preferences.

Customising the icon bar

You can add, rearrange, 

and remove shortcuts 

from the icon bar to suit 

your needs. To modify the 

icon bar, go to the View 

menu and then click the 

Customise Icon Bar.

Too many windows open?

If your QuickBooks work 

area becomes too cluttered 

with windows that you 

have open, you can close 

them all at once instead of 

closing them one at a time. 

To close all open windows, 

go to the Window menu 

and click Close All.

When you close your 

company " le at the end of 

the day, it’s good practice to 

close all windows that you 

have open. The next time 

you open your company " le, 

QuickBooks will open all 

the windows that you had 

open when you closed your 

company " le. If you forget 

to close open windows 

when you exit QuickBooks, 

hold down the Alt key while 

opening your company 

" le. QuickBooks will open 

your company " le with no 

windows open in your work 

area.
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Easily access your customer’s

contact information and any

notes on that customer.

Click a customer in the 

Customers & Jobs list to view

useful data.

View all of your past trans- 

actions with this customer,

or !lter this list to display only

one type of transaction, like

overdue invoices.

Run quick reports that pertain

to this customer.

Use the Transactions tab to

!nd, sort, and !lter all your 

transactions across all of 

your customers.

Easily add customers and jobs.

Create new transactions

(estimates, invoices, sales

orders). 

Figure 3. View and manage customers, suppliers, and employees with the QuickBooks 
Centres

Supplier Centre

The Supplier Centre gives you a complete picture of where your money is going. From 
one screen, you can see all your suppliers and exactly what you owe them. Simply click 
a supplier’s name to view your entire history with that supplier. You no longer need to 
run separate reports to see exactly how much business you’re doing with each individual 
supplier. And, you can sort your bills by due date so you can stay on top of your " nances. 

If you need to talk to a supplier, click their name and you’ll see all their contact information. 
If a supplier calls you to follow up on a late payment, you can quickly look up the bill and 
see when you paid it and what the cheque number was. 

Employee Centre

From the Employee Centre, you can see exactly what you’re paying each employee. Simply 
click an employee’s name to view that person’s payroll history. And if you need to get in 
touch with an employee, their contact information is right in front of you.
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Payroll Centre

If you subscribe to the QuickBooks Payroll service (additional fees apply), the Employee 
Centre includes a Payroll Centre. Use the Payroll Centre to manage your payroll.1

The Payroll Centre is the hub for managing all payroll activities. The Payroll Centre reminds 
you of important payroll dates so you pay your employees, pay your payroll liabilities, and " le 
forms on time.

To view the Payroll Centre, click the Employees menu and select Payroll Centre.

Displaying multiple windows or one window

QuickBooks is preset to show multiple windows at a time. By doing so, you can easily 
navigate between tasks as well as compare data in multiple windows. When you open a 
window, it opens to a preset size and location. You can resize and move each window as you 
see " t.

Depending on how you size or arrange the windows, some windows might not be visible. Use 
the Window menu to view a list of the open windows. Simply click the window name in the 
list to bring it to the front.

Alternatively, you can open the Open Window List to have the list of open windows always 
visible on the left side of the QuickBooks application window. If you prefer to view only one 
window at a time, go to the View menu and click One Window.

Adding icons to the icon bar

For quick access to the areas of QuickBooks you use most, you can customise the icon bar 
by adding many of the features and reports that you use most frequently.

View Lists

Open Window List

Icon Bar

Customise Icon Bar...

Add “Chart of Accounts”  to Icon Bar...

Accountant Company

Navigation Bar

Custom

 

To add a shortcut to a QuickBooks

window, open the window and then

go to the View menu and click

the Add to Icon Bar option.

You can add, rearrange, or remove

shortcuts from the icon bar in the

Customise Icon Bar window.

Note: Some QuickBooks windows cannot be added to the icon bar.

1.  Add-on services require a subscription and Internet access for certain features, including tax table 

updates.
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Getting Answers to Your Questions

QuickBooks provides a variety of tools and resources to help you " nd answers to questions 
you might have when using QuickBooks. Available resources include:

• QuickBooks Learning Centre

• In-product Help

• Additional self-help tools

• Assisted support

• ProAdvisors

Check out the QuickBooks Learning Centre

As you begin using QuickBooks, one of the " rst things you’ll see is the QuickBooks Learning 
Centre. The Learning Centre provides links to overview help topics that help you learn how 
to use QuickBooks and complete common business tasks. 

To open the QuickBooks Learning Centre later, go to the Help menu and click Learning 
Centre.
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Using in-product Help

QuickBooks in-product Help provides background information and instructions for doing 
QuickBooks tasks. You can access the Help content and features in several ways.

To use in-product Help, go to the Help menu and click QuickBooks Help.

Enter a question in the 

Search tab and click Ask to 

search the entire Help 

system for the information 

you want.

Let us know if the Help topic

answered your question and

what we can do to improve

Help.

Use the Index tab to !nd Help topics for a

speci!c QuickBooks term or concept. Enter 

a keyword in the !eld or scroll through the list.

Click the Printer icon to

print a topic.

Getting step-by-step instructions

Throughout QuickBooks you’ll " nd windows with a How Do I button. Clicking this button 
provides quick access to instructions for tasks associated with the window.

x

vable
Asset
ble

Liabi...

Balance Total

Ask How Do I?

9,685.00
40,050.00

75.00
0.00
0.00

500.00
0.00
0.00

49,500.00

Type your question here

Add new accounts and subaccounts

Remove an account from the list

Change information for existing accounts

Transfer funds between accounts

Rearrange this list of accounts

What if I mix business and personal funds?

Use online account access

Enable a credit card for online access

Change account information

Rename an account
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Viewing Help for a window you have open

If you are unsure how to use a particular QuickBooks window, press the F1 key on your 
keyboard to get help. (You can also click the Help button to view these Help topics.) These 
Help topics provide answers to questions such as:

• What can I use this form for?

• What does this button do?

• What kind of information is displayed in this column?

• What happens when I select this option?

Using Help Search and Index to ! nd information 

QuickBooks in-product Help is quite extensive. Use the Help Search and Index to " nd 
answers to your questions quickly.

To ! nd information using Search:

• Type your question in the Ask " eld in the title bar of most QuickBooks windows and click 
Ask; or

• Go to the Help menu, click QuickBooks Help, and then click the Search tab. Enter your 
question in the Search " eld and click Ask.

Tip: Using Search Effectively  Entering questions of 3-10 words produces better 
search results than simple keywords. For example, instead of typing “invoices,” enter 
How do I create invoices? in the Ask " eld.

Make your questions as speci" c as possible. They should not get too long or contain 
too many keywords. For example, “How do I add customers?” will return better 
results than “How do I add new customers and suppliers?”

If you get no search results, check the spelling in your question. QuickBooks knows 
about some common misspellings, but other misspellings will not be caught. Do not 
use abbreviations. Try different keywords.

If you can’t " nd your answer in the topics returned by search, click the Show all 
results checkbox to see more topics.

To ! nd information using the Index:

➊   Go to the Help menu, click QuickBooks Help, and then click the Index tab.

➋   Enter a term in the blank " eld. The index will scroll and display the available entries.

➌   Double-click the index entry that best describes that information you want.

Using the sample company ! les

QuickBooks includes several sample company " les that you can practice with to enter 
pretend data, run reports, and explore QuickBooks features.
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Did You Know?
To open a sample company " le, go to the File menu, click 
Open or Restore Company, and then click a sample company 
" le from the list.

Additional Self-Help Tools

If you cannot " nd the answer you want in the in-product 
Help, try these other resources.

Support Resources page in QuickBooks

From the Support Resources page, you can:

• Find additional troubleshooting tips

• Learn about your assisted support options and how to 
contact Intuit

• Learn about and sign up for support plans

• Find a QuickBooks ProAdvisor

• Learn about training resources

To open the Support Resources page, go to the Help menu 
and click Contact Support.

QuickBooks UK Community

Use the QuickBooks UK Community 
(http://community.quickbooks.co.uk) to connect with other 
QuickBooks users and experts to " nd answers and share 
advice. From the communities, you can " nd discussion 
boards, blogs, and articles.

To check out and register for the QuickBooks Communities, 
go to the Help menu, click Contact Support, and then click 
Go to the QuickBooks Online Community.

Online Knowledge Base

The online QuickBooks Knowledge Base 
(faq.quickbooks.co.uk) provides a free library of articles for 
each QuickBooks product family. In the Knowledge Base, 
you can " nd:

• Answers to common user questions

• Product update information

• Useful links to product updates, support plans, customer 
service, and current news articles

• Technical help for a variety of QuickBooks issues

Getting help from 

QuickBooks professionals

Want local professional 

help setting up or 

customising your 

QuickBooks? You’ll get the 

most out of QuickBooks 

when a QuickBooks 

ProAdvisor helps you 

customise the software for 

your unique needs.

• Save time and money by 

getting your QuickBooks 

setup right the " rst 

time, rather than " xing 

mistakes down the road.

• ProAdvisors can help 

you set up appropriate 

reports so you can easily 

understand the health of 

your business

If you don’t currently 

work with an accounting 

professional, or your 

accountant isn’t a 

QuickBooks expert, you 

can look for a QuickBooks 

ProAdvisor in your area 

who can help you set 

up and customise your 

QuickBooks by visiting 

www.quickbooks.co.uk and 

clicking the “local help” 

button.
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Getting Assisted Support

If you cannot " nd the answer you want using the in-product Help or other self-help tools, get 
assistance from a QuickBooks expert.

To learn more about free and paid QuickBooks Assisted Support options and how to get 
help, go to the Help menu and click Contact Support or open a web browser and visit 
www.quickbooks.co.uk.

Working with a QuickBooks ProAdvisor

From time to time, you might need advice that is very speci" c to your business situation. In 
this case, you’ll want to contact your accountant or another specialised professional.

If you do not have an accountant or bookkeeper working for you, you can " nd a QuickBooks 
ProAdvisor located near you from our Web site. QuickBooks ProAdvisors are independent 
accountants, bookkeepers, computer consultants, and trainers who work with small 
businesses every day. They can offer guidance on everything from business planning to tax 
advice.

To " nd a ProAdvisor in your area, open a Web browser and enter the URL: http://www.
quickbooks.co.uk/

From there, under ProAdvisors, click the “local help” button.
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QuickBooks Basics
To take full advantage of QuickBooks, there are some important concepts you need to 
understand.

How QuickBooks lists work

Lists are one of the important building blocks that make QuickBooks so powerful and 
ef" cient. You use information stored in lists to " ll out most QuickBooks forms. For example, 
to create an invoice, you choose the customer name from your Customers & Jobs list. 
QuickBooks automatically enters the customer information on the form for you. This saves 
you time and prevents typing errors. You can also change the information directly on the 
form as needed. Lists are easy to set up in QuickBooks, but do require careful planning.

Depending on the type of list you want to use, you can get to the list in one of two ways:

• QuickBooks Centres: Your Customers & Jobs, Suppliers, and Employees lists are 
available in the Customer, Supplier, and Employee Centre, respectively. Click the 
appropriate QuickBooks Centre button on the navigation bar to go to a QuickBooks Centre. 
Then, click the tab for your list.

• List windows: Other lists, such as the Chart of Accounts and Item List, appear in separate 
windows. To view one of these lists, click the Lists menu and then click the list you want. To 
enter information in these lists, use the menu button at the bottom of the list to add, edit, or 
delete list items. The list menu also provides access to common features associated with 
the list.

      

The more detail you enter for each list item, the more information QuickBooks can use to 
pre-populate forms, track " nancial data, and display useful reports about your business. 
Another advantage of lists is that common tasks like adding list entries, editing list 
information, and deleting list entries are performed the same way.

Figure 4 illustrates how QuickBooks uses list information across multiple windows and tasks 
to simplify data entry and to give you a complete picture of how your business is doing.
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x

Customer Name Andrew Reback

1,000.00Opening Balance as of 15/12/2008

Address Info

Categorizing and Defaults

Commercial

Commercial

Net 30

Type

Terms

Rep

Mail

Preferred Send Method

Additional Info

OK

Cancel

Next

Help

Customer is
inactice

Define Fields

VAT Information
Country

Tax Code

S
VAT Registration No.

United Kingd...

How do I determine
the opening balance?

Type a help question Ask How Do I?New Customer

Payment Info

Price Level

Custom Fields

Contract #

B-Day

Spouse’s Name

Job Info1

2

4

2. Enter customer information in the
    New Customer window.

4. Pick a customer name 
    from the list and choose
    to create an invoice from
    the New  Transactions 
    menu. The customer 
    information is entered
    automatically.

5. All invoices for this customer are listed in the
    Transaction Details area.

6. To view a list of invoices for all your customers, 
    use the Transactions tab.

3. The information for the new
    customer appears in the
    Customers & Jobs list.

1. Use the Customer Centre to view customer data.
    Click New Customer & Job to add a customer
    to your list.

65

3

Figure 4. How QuickBooks reuses list information to make your life easier

Entering list information as you work

There are two basic methods you can use to enter list information in QuickBooks. You can enter 
account, customer, supplier, product, and service information before you enter transactions in 
QuickBooks, or you can enter this information “on the % y” as you use the product.

If you prefer to enter information as you use QuickBooks to perform your daily tasks, 
QuickBooks prompts you to immediately set up any entry it does not know about. For example, 
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Did You Know?
if you try to create an invoice for a customer named John 
Walker and you have not entered information about John 
Walker into QuickBooks, QuickBooks will prompt you:

Clicking Quick Add creates a new customer list entry for 
John Walker in the Customers & Jobs list and adds all the 
information you enter about the customer on the invoice 
form (billing address, payment terms, taxable status).

Clicking Set Up takes you to another window where you can 
enter information not covered by the invoice. For example, 
you could click Set Up to enter John Walker’s phone number, 
fax number, and credit limit.

Writing cheques versus paying bills

In QuickBooks, you can manage your bills and payments in 
two ways:

Write cheques to pay bills now. Use the Write Cheques 
window and assign the amounts to appropriate expense 
accounts.This method is recommended when you don’t 
receive a bill, such as when you go to the store and write 
a cheque and then you need to record that expense in 
QuickBooks. You can also use Write Cheques to pay a 
bill as soon as you receive it, as long as you don’t need 
to track the bill.

Enter bills when you receive them and pay them later. 
Use the Enter Bills window to enter bills when you 
receive them. Then use the Pay Bills window to pay 
bills when they are due. You can set up QuickBooks to 
remind you to pay bills when they are due.  Using this 
method, you keep your money in your business for as 
long as possible. You might still use a cheque to pay the 
bill, but this method enables you to track how much money 
you owe. And at any time, you can run reports to analyse 
unpaid bills for information such as which suppliers you 
owe money.

Note: Do not simply write a cheque in the Write Cheques window to 

pay bills that you entered in the Enter Bills window or the accounts 

payable registers.

What happens when I 

record a bill payment?

If you paid by:

• Cheque. QuickBooks 

prepares one cheque 

for each supplier and 

records the cheques 

in the current account 

register with BILLPMT in 

the Type " eld.

• Credit card. QuickBooks 

records a charge for 

each supplier in your 

credit card register.

• Cash. QuickBooks 

records a payment for 

each supplier in your 

cash account register.

• Online banking payment. 

QuickBooks prepares one 

online banking payment 

instruction for each 

supplier and records the 

payments in the current 

account register with 

BILLPMT in the Type " eld.

In each scenario, 

QuickBooks records the 

payment to each supplier 

in the accounts payable 

register. The amount 

you paid appears in the 

Payment column.
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Figure 5 illustrates the difference between writing cheques versus entering and paying bills.

Write cheques now
Enter bills now,
pay when due

Receive bill from supplier

WRITE CHECKS 

Your CompanyCustomer:

Amount Due

Bill Due

BILL                                          Payment Due to Gallion Masonry

Date 14/07/2008

13/08/2008

1,550.00

P a y to the Order o f Gallion Masonry 

One thousand fi v e hundred fif t y and 00/100* * * * * * * * * * * * * * * * * * * * * * * * *  * 

Address 

Memo 

N o . 302 

1,550.00 £

Pounds

Date 14/07/2008

Gallion Masonry 
189 Old B a yshore R d 
B a yshore CA 9432 6 

ENTER BILLS 

x

Select Bills to be  P ai d 

Show Bills 
Due on or before 

Show all bills Sort Bills By Due Date 

Date Due 

31/05/2008

31/05/2008

K ersh a w Compu.. . 

K ersh a w Compu.. . 

13,000.00 

6,500.00 

0.00 

6,500.00 

6,500.00 0.00 0.00 19,500.00 T otal s 

0.00 

0.00 

0.00 

0.00 

V endo r R e f . N o . Disc. Date 

Discount & Credit Information for Highlighted Bill
Supplier

Bill  R e f . N o . 

P a yment Accoun t 

Clear Selections 

Bank Account Cheque

P a yment Metho d 

T o be printe d 

P a yment Dat e 

Assign cheque no.

T erm s Kershaw Computer Se... 

Sugg. Discount 

Number of Credits 

T otal Credits  A v ailabl e 

Amt. Due Disc. Used Credits Used Amt.  T o  P a y 

24/07/2008

14/07/2008

Pay Bills 

Clear P a y & Clos e Pay & New 

Ending Balance 

0.00 

Net 30 

0.00 

0 

678.06 

Go to Bill Set Discount Set Credits 

Ask How Do I? 

x

Previous Next Print Find Journal 

P a y to the Order o f Gallion Masonry 

One thousand fi v e hundred fif t y and 00/100* * * * * * * * * * * * * * * * * * * * * * * * *  * 

Address 

Memo 

Expenses £1,550.00 Items £0.00 Online  P a ymen t T o be printe d 

Memo Customer:Job Account 

Job Expenses: Job Materials 1,550.00 Ba k e r , Chri s 

Amount 

N o . 302 

1,550.00 £

Pounds

Clear Clear Splits R ecalculat e S av e & Clos e 

7,178.06 

Type a help question Ask How Do I? Write Cheques - Bank Account

Bank Account Ending Balance 

Date 14/07/2008

Bank Account

Save & New 

Gallion Masonry 
189 Old B a yshore R d 
B a yshore CA 9432 6 

Pay Supplier

Print cheques

Pay Bills 

Enter Bills Write Cheques

Type a help question 

Type a help question x

Previous Next Find History Journal 

Gallion Masonry V endo r 

Discount Date 

T erm s R e f . N o . 

Amount Due 

Bill Due 

Net 30 

Bill 

Memo 

Expenses £1,550.00 Items £0.00

Memo Customer:Job Account 

Job Expenses: Job Materials 1,550.00 

Amount 

Clear Clear Splits R ecalculat e S av e & Clos e 

Ask How Do I? Enter Bills 

Bill  R ecei v e d 

Date 07/14/2004 

08/13/2004 

1,550.00 

Bill Credit 

Save & New 

1234 Garcia Ave.
Twyford Reading RG10 9BF

Address:

Figure 5.  Writing cheques versus entering and paying bills
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QuickBooks Workflow  |  Visual Overview

Pay Bills 

Bank 
Accounts 

Sales 
Receipts 

Deposits 

Invoices Estimates 

Write
Cheques

Issue 
Credits/Refunds 

Pay 
Employees 

Setting Up Your Business Money In Money Out

                  Create Reports

Accounts

Receive 
Payments 

Managing Your Business QuickBooks Services and Other Solutions

Suppliers

Employees & Payroll

Customers

S

Items

Preferences

VAT
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Learning how to do essential QuickBooks tasks
The diagram to the left shows a visual overview of the essential tasks that most people use 
to run their company in QuickBooks. This chapter describes how to perform each of these 
tasks and offers important usage tips.

The tasks are written assuming that you want to set up all the information for your business 
(for example, customer, supplier, and account information) before you begin creating 
invoices, receiving payments, or paying your bills.

However, you might prefer to enter information as you need it. For example, you might create 
an invoice for a new customer and use Quick Add (described on page 39) to enter the 
customer information “on the % y.” Either method works " ne. You choose the method that 
works best for you.

Essential Tasks
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Setting Up Your Business  |  Preferences

Preferences: Modify QuickBooks for the way you work

Set personal and company

preferences for each 

QuickBooks area.

Choose a group from the 

preference list to set 

behaviour for other 

QuickBooks areas.

3

Click General to set

general QuickBooks 

preferences.

2
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Did You Know?
Changing QuickBooks for the way 
you like to work
You can modify QuickBooks in many ways to suit the 
needs of your business and your personal style of working. 
From the QuickBooks Preferences window, you can de" ne 
preferences in over a dozen different categories.

For example, you can con" gure general preferences such as 
whether or not QuickBooks prompts you before editing or 
deleting a transaction, or which date QuickBooks uses for 
new transactions. Or, you can con" gure accounting-speci" c 
preferences such as how QuickBooks displays accounts and 
subaccounts.

To view and set preference options:

➊ Go to the Edit menu and click Preferences. 

➋ In the Preferences window, change any of the general 
QuickBooks preferences. These preferences determine 
how QuickBooks behaves.

➌ To display the preferences for another area of 
QuickBooks, click the appropriate category in the list on 
the left. For example, to set preferences for reporting 
functions, click Reports & Graphs. 

➍ On the My Preferences tab for the particular feature 
area, enter the changes and settings you want. These 
settings affect only your QuickBooks sessions, not those 
of other users.

➎ Do one of the following: 

• Click OK to close the Preferences window and save 
your changes. 

• Click another feature area in the scroll box to enter 
other preferences. Click Yes when prompted to save 
your changes.

➏ Click OK.

Company preferences

Company preferences are 

global preferences that 

affect all users of the 

company " le. Only the 

QuickBooks Administrator 

can set up or modify 

company preferences.

My Preferences

You can customise your 

work% ow by setting 

personal QuickBook 

preferences, such as using 

the Enter key instead 

of the Tab key to move 

between " elds.
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Setting Up Your Business  |  Adding an Account

Chart of Accounts

Add New Account

 Set up QuickBooks to 

 automatically remind you 

 when to order cheques for 

 an account.

QuickBooks supports many 

different types of accounts.

Click here to make the 

account a subaccount of 

another account.

Click here to enter an

opening balance for the

account (for balance sheet

accounts).

FPO 

x

Name T yp e Balance  T ota l 

Type a help question Ask How Do I? 

Account Activities R eport s Include inacti v e Include inacti v e 

Chart of Accounts 

Current Account
S a ving s 
Cash Expenditures 
Barter Account 
Accounts  R ecei v abl e 
T ools & Equipmen t 
Empl o y ee Loan s 
I n v entory Asse t 
R etainag e 
Undeposited Funds 
Land 
Buildings 
T ruck s 

Bank 
Bank 
Bank 
Bank 
Accounts  R ecei v abl e 
Other Current Asset 
Other Current Asset 
Other Current Asset 
Other Current Asset 
Other Current Asset 
Fi x ed Asse t 
Fi x ed Asse t 
Fi x ed Asse t 
Fi x ed Asse t 
Fi x ed Asse t 
Fi x ed Asse t 
Other Asset 
Accounts  P a y abl e 
Credit Card 
Credit Card 
Credit Card 
Credit Card 
Credit Card 
Other Current Liabili t y 
Other Current Liabili t y 
Other Current Liabili t y 
Long  T erm Liabili t y 
Long  T erm Liabili t y 
Long  T erm Liabili t y 
Long  T erm Liabili t y 
Equi t y 
Equi t y 

7,178.06 
13,868.42 

0.00 
0.00 

76,610.00 
5,000.00 

0.00 
23,102.54 
2,461.80 

36,982.34 
90,000.00 

325,000.00 
78,352.91 
28,501.00 
7,325.00 

-121,887.78 
1,041.85 

50,239.38 
70.00 
45.00 
25.00 
0.00 

5,071.02 
0.00 

3,302.06 
5,353.52 

19,932.65 
3,911.32 
3,440.83 

50,162.38 
403,590.82 
19,000.00 

New 

Edit 

Delete 

Ma k e Account Inactive

Show Inacti v e Account s 

Hie r archical Vie w 

Flat View 

Customise Columns.... 

Ctrl+N 

Ctrl+E 

Ctrl+D 

Ctrl+U 

Ctrl+P 

Import from E x cel.. . 

Use 

Find  T r ansactions in.. . 

Print List... 

R e-sort Lis t 

Click the Account button to

create new accounts or

perform tasks with existing

accounts. 2

 

The Chart of Accounts list

shows the balance of each 

balance sheet account for 

your business.

1

 Rearrange your accounts by 

 clicking and dragging the 

 diamond to the left of an 

 account to a new position.

3

5

7
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Adding an Account
When you set up your company " le, QuickBooks sets up 
certain accounts for you automatically. However, as your 
business grows or changes, you might need to add new 
accounts to your chart of accounts to better organise your 
" nances. Or, you might need an account that was not 
provided during setup. For example, you might want to 
create expense accounts to track of" ce supply purchases 
separately from advertising costs.

To add an account:

➊ Go to the Lists menu and click Chart of Accounts.

➋ Click the Account button and then click New.

➌ In the Add New Account: Select Account Type window, 
select the type of account you want to create and then 
click Continue.

Note: Refer to pages 48 and 49 for a description of the different 

types of income, expense, and balance sheet accounts.

➍ Enter the account’s name in the Account Name field. This 
name will appear on your company financial statements.

➎ If you want to make this account a subaccount of 
another account, select the Subaccount of checkbox. 
From the drop-down list, click the account that will be the 
higher-level account for this subaccount.

➏ (Optional) Enter a short description, note, bank account 
number, or credit card number, depending on the type of 
account you are adding.

➐ For balance sheet accounts. Enter an opening balance 
based on the account’s balance as of your QuickBooks 
start date. Generally, you should enter any balance sheet 
balances as of the day before your start date. That way 
it’s all exactly correct at the opening of your start date. If 
you’re putting money into the account with a transaction, 
do not use the opening balance field, since this will 
create an additional transaction. If you’re not sure of 
the balance, you can leave the field blank and enter the 
information later. Click OK when finished.

➑ Click Save & Close or Save & New to add another account.

Accounts

There are two types of 

accounts:

Balance sheet accounts, 

that track your assets and 

liabilities (such as bank 

accounts or accounts 

payable)

Income and Expense 

accounts, which are used 

to track where your income 

came from and what you 

spent the money on, such 

as of" ce supplies, rent, 

and utilities.

Refer to pages 46 and 

47 for a description of 

the different QuickBooks 

accounts.

Chart of Accounts

A complete list of your 

business’ accounts and 

their balances. You use a 

chart of accounts to track 

how much money your 

company has, how much 

money it owes, how much 

money is coming in, and 

how much is going out.

Did You Know?

It is recommended that you 

open a business current 

account for writing cheques 

as one of the " rst things 

you do when starting a new 

business.

Key Terms
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Why Use Subaccounts?

When you need more detail about what’s going on in an account, you can divide the account 
into one or more subaccounts. Subaccounts let you track several related types of income or 
expenses independently yet keep them all under the “umbrella” of a single parent account. 
Subaccounts appear indented immediately below their parent account in your chart of 
accounts. If you create subaccounts, it’s best not to post anything to the “parent” account 
For example, if your business has substantial advertising expenses, you might decide to 
divide your Advertising expense account into several subaccounts, such as Newspaper Ads, 
Signs, Yellow Pages Listing, and Direct Mailings.

For a brand new account

When you create a brand new account, leave the opening balance at zero. Its opening 
balance will be created automatically when you transfer funds from another account.

What type of account should I use?

There are two main types of accounts in the QuickBooks chart of accounts:

• Income and expense accounts

• Balance sheet accounts

Income and Expense Accounts

Income and expense accounts track the sources of your income and the purpose of each 
expense. When you record transactions in one of your balance sheet accounts, you usually 
assign the amount of the transaction to one or more income or expense accounts. For 
example, not only do you record that you took money out of your current account, but you 
keep track of what you spent the money on (utilities or of" ce supplies).

Account type Purpose

Income
Categorises money earned from normal business operations, such as 
product sales, service sales, and discounts to customers.

Other income
Categorises money your business earns that is unrelated to normal 
business operations, such as dividend income, interest income, and 
insurance reimbursements.

Expense
Categorises money spent in the course of normal business operations, 
such as advertising and promotion, of" ce supplies, insurance, legal fees, 
payroll, charitable contributions, and rent.

Other expense
Categorises money your business spends that is unrelated to normal 
business operations, such as corporation taxes and penalties and legal 
settlements

Cost of goods sold
Tracks the direct costs to produce the items that your business sells, 
such as cost of materials, cost of labour, subcontractors, and shipping.

Note: QuickBooks does not display balances for income and expense accounts in the Chart of Accounts. To 

see these balances, go to the Reports menu, click Report Centre, and then click the Company & Financial 

category. You can also select the income or expense account in the chart of accounts and click QuickReport.
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Balance Sheet Accounts

QuickBooks provides 10 types of balance sheet accounts to choose from as you 
create and add to your Chart of Accounts. Use the type of account that best describes 
the type of data you are tracking.

Account type Purpose

Bank
Tracks money you have in your cash accounts. Create one for each cash 
account, such as petty cash, current, and savings.

Accounts 
receivable
(A/R)

Tracks money your customers owe you on unpaid invoices. Most 
businesses require only the A/R account that QuickBooks automatically 
creates.

Other current asset
Tracks the value of things that you can convert to cash or use up within 
one year, such as prepaid expenses, employee cash advances, stock, and 
loans from your business.

Fixed asset
Tracks the value of signi" cant items (consult your tax professional for a 
minimum cash amount) that have a useful life of more than one year, such 
as buildings, land, machinery and equipment, and vehicles.

Other asset
Tracks the value of things that are neither Fixed Assets nor Other Current 
Assets, such as Goodwill, long-term notes receivable, and security 
deposits paid.

Accounts payable
(AP)

Tracks money you owe to suppliers for purchases made on credit. Most 
businesses require only the A/P account that QuickBooks automatically 
creates.

Credit card
Tracks credit card purchases, bills, and payments. Create one for each 
credit card your business uses.

Other current 
liability

Tracks money your business owes and expects to pay within one year, 
such as VAT or security deposits/retainers from customers.

Long-term liability
Tracks money your business owes and expects to pay back over more 
than one year, such as mortgages, long-term loans, and notes payable.

Equity
Tracks money invested in, or money taken out of, the business by owners 
or shareholders. Payroll and reimbursable expenses should not be 
included.
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Customer Centre

New Customer

Click New Customer & Job 

to add new customers to 

the list.

Click a customer’s name in

the list to view the contact

information and notes for

that customer.

View the amount of money

each customer owes you in

the Balance Total column.

2

x

Customer Name Andrew  R ebac k 

1,000.00 Opening Balance as of 15/12/2008

Address Info 

Categorizing and Defaults 

Commercial 

Commercial 

Net 30 

T yp e 

T erm s 

R e p 

Mail 

Preferred Send Method 

Additional Info 

OK 

Cancel 

Next 

Help 

Customer is 
inactice 

Define Fields 

VAT Information
Country

T ax Cod e 

S
VAT Registration No.

United Kingd...

How do I determine 
the opening balance? 

Type a help question Ask How Do I? New Customer 

P a yment Inf o 

Price Le v e l 

Custom Fields 

Contract #

B-Day

Spouse’s Name

Job Info 3

4

Enter the customer’s name,

address, and contact 

information on the Address 

Info tab. 

Use the Additional Info and 

Payment Info tabs to set up 

customer payment terms and 

VAT information.

5

Click De!ne Fields to create 

any custom !elds that you 

need for your customers.

 

See all transactions for this

customer in the transaction

list, which can be sorted and

!ltered.

Click to view useful reports

about each customer.
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Adding Customers
Customers are the lifeline of your business. By entering 
detailed information in QuickBooks about the people and 
companies to whom you sell your products and services, 
you can personalise their bills, send invoices easily, and 
quickly view the status of their accounts. You can add new 
customers at any time.

Tip  Typing in customer data for hundreds of customers 
can be a tedious task. If you use Microsoft Outlook, 
you can import your existing customer information into 
QuickBooks instead of entering it manually. Refer to 
the QuickBooks in-product Help for instructions on how 
to prepare your customer data " le for importing into 
QuickBooks. When you are ready to synchronise your 
customers, refer to the instructions on page 24.

To add a customer:

➊ Click the Customer Centre icon at the top of the 
QuickBooks window.

➋ Click New Customer & Job and then click New Customer.

➌ On the Address Info tab, enter all the data that you have 
about the customer, including their name, Invoice to and 
Ship to addresses, and additional contact information.

➍ Complete the Additional Info and Payment Info tabs, as 
appropriate.

➎ If you want to add additional fields to the form, click 
Define Fields to customise the form.

➏ Click OK or Next (if you want to enter another customer).

Tip  You can also add customers as you perform your 
everyday tasks. For example, if you enter the name of 
a new customer when " lling out an invoice, QuickBooks 
will prompt you to enter information about this customer. 
You can choose from two quick setup options:

• Quick Add—Adds just the name to the list. You must 
add the details later.

• Set Up—Enables you to enter additional information 
(such as a phone number, fax number, and alternate 
contact) to the list you choose.

Customers

Customers are the people 

or businesses to whom 

you sell your products 

or services—that is, 

the people who pay you 

for what you do. Some 

businesses might refer to 

a customer as a client or 

member.

Did You Know?

Adding jobs

If you are performing 

more than one job for a 

customer, you can track 

the jobs individually by 

adding new jobs under the 

customer’s name in the 

Customers & Jobs list. 

That way, you can create 

reports that show the 

income and expenses for 

each job. To add a job, 

click New Customer & Job 

and then click Add Job.

Importing customers

If you need to add 

several customers to your 

QuickBooks company " le, 

consider using the Import/

Export functions to enter 

multiple customers at one 

time. For more information, 

see QuickBooks Help for 

importing lists.

Key Term
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Supplier Centre

New Supplier: Additional Info

Use the Additional Info tab  

to enter supplier-speci!c 

information, including the 

supplier type.

Click De�ne Fields to create 

any custom !elds that you 

need for your supplier.

x

Supplier Name

Opening Balance 

P ang Building Supplie s 

2,500.00 as of 15/12/2007

Address Info 

Account N o . 

10,000.00

Categorising and Defaults

T yp e 

Materials 

Due on receipt 

T erm s 

Credit Limit

Additional Info 

OK 

Cancel 

Next 

Help 

Supplier is
inactiv e 

Define Fields 

How do I determine 
the opening balance? 

Type a help question Ask How Do I? New Supplier

Custom Fields 

Billing  R ate Le v e l 

Discount Available

Supplier is a
VAT Agency

VAT Information

Country

United Kingdom

VAT Registration No.

View the amount of money

you owe each supplier in the 

Balance Total column.

3

Enter the supplier’s name, 

address, and contact 

information on the Address 

Info tab. 

5

6

Click New Supplier to add

new suppliers to the list.
2

Click a supplier’s name in

the list to view the contact

information and notes for

that supplier.

See all transactions for this 

supplier in the transaction

list, which can be sorted and

!ltered.

Click to view useful

reports about each

supplier.
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Adding Suppliers
QuickBooks uses the supplier list to hold information about 
the people and companies you buy goods and services from 
to run your business; for example, this list could include 
the phone company, your of" ce stationery supplier, and your 
Utilities provider. You can add new suppliers at any time.

Tip  Typing in supplier data for hundreds of suppliers 
can be a tedious task. If you use Microsoft Outlook, 
you can import your existing supplier information into 
QuickBooks instead of entering it manually. Refer to 
the QuickBooks in-product Help for instructions on 
how to prepare your supplier data " le for importing 
into QuickBooks. When you are ready to synchronise 
your suppliers, refer to the instructions on page 24.

To add a supplier:

➊ Click the Supplier Centre icon at the top of the 
QuickBooks window.

➋ Click New Supplier.

➌ On the Address Info tab, enter all the data that you have 
about the supplier, including their name, address, and 
additional contact information.

➍ If you owe the supplier money as of your company’s start 
date, enter the amount in the Opening Balance field. 

➎ Click the Additional Info tab and complete the form.

➏ If you want to add additional fields to the form, click 
Define Fields to customise the form.

➐ Click OK or Next (if you want to enter another supplier).

Tip  You can also add suppliers as you perform your 
everyday tasks. For example, if you enter the name of a 
new supplier when paying a bill, QuickBooks will prompt 
you to enter information about this supplier. You can 
choose from two quick setup options:

• Quick Add—Adds just the name to the list. You must 
add the details later.

• Set Up—Enables you to enter additional information 
(such as a phone number, fax number, and alternate 
contact) to the list you choose.

Setting Up Your Business

Suppliers

Suppliers are any 

businesses or people 

from whom you buy or rent 

goods or services for your 

business—of" ce supplies, 

phone or computer 

services, or products that 

you sell. The tax agencies 

that you pay (such as 

HM Revenue & Customs 

for VAT) are also your 

suppliers. Nearly everyone 

you pay other than 

employees are suppliers.

Did You Know?

Importing suppliers

If you need to add 

several suppliers to your 

QuickBooks company 

" le, consider importing 

all your suppliers at the 

same time. Refer to 

the in-product Help for 

instructions on how to 

Import lists.

Key Term
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x

T yp e 

Service 

P a vin g Labour

Use for services y ou charge for or purchase, li k e 
speciali sed labour, consulting hours, or professional
fees. 

Item Name/Number 

Description  

How can I set rates by customers or employees?

Subitem of 

R at e 

Account 

This service is performed  b y a subcont r acto r , owne r , or partner   

OK 

Cancel 

Next 

Custom Fields 

Spelling 

Item is inacti v e 

Type a help question Ask How Do I? New Item 

Sales VAT

0.00 S

Item List

New Item

Subitems are indented under 

the parent item.

3

Choose the type of item you 

want to create from the Type 

drop-down list.

 

x

0.00 
0.00 
0.00 

55.00 
35.00 
0.00 

0.365 
35.00 
35.00 
0.00 
0.00 
0.00 
0.00 
0.00 
0.00 
0.00 
0.00 
0.00 
0.00 
0.00 
0.00 
0.00 

1,799.00 
0.00 
0.00 
0.00 

30.00 
38.00 
0.00 

120.00 
72.00 
0.00 

0 

0 
104 

8 
2 
0 

460 
103 
110 

0 
3 

32 
4 

0 

0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 
0 

Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Mileage... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 
Constru... 

Name Description T yp e Account On Hand Price On Sales Order 

Type a help question Ask How Do I? 

Item Activities R eport s Include inacti v e Include inacti v e 

Item List 

B luep r i n t change s 
C onc r e t e  S la b 
F l o or  P lan s 
F r amin g 
Install a tio n 
La bour
M ileag e 
R em o v a l 
R epair s 
Subs 
        C a r p e t 
        D r y w al l 
        D u c t  W o r k 

F oundation slab - prep and pourin g 
Floor Plans 
F r aming labo ur
Installation labour

R em o v al labo ur
R epair wor k 
Subcont r acted service s 
Install carpeting 
Install dry w al l 
Heating & Air Conditioning Duct  W or k 

Install tile or counter 

Light pine kitchen cabinet  w all uni t 
standard interior door f r am e 

standard interior b r ass hing e 
Standard Doorknobs 
Locking interior doorknobs 

Exterior wood doour
Interior wood doour
complete Interior door 

Service 
Service 
Service 
Service 
Service 
Service 
Service 
Service 
Service 
Service 
Service 
Service 
Service 
Service 
Service 
Service 
Service 
Service 
Service 
Service 
Stock Part
Stock Part
Stock Part
Stock Part
Stock Part
Stock Part
Stock Part
Stock Part
Stock Part
Stock Part
Stock Part
Stock Part

Import from E x cel.. . 

Use 

Find in  T r ansactions.. . 

Print List... 

R e-sort Lis t 

Ctrl+N 

Ctrl+E 

Ctrl+D 

Ctrl+U 

Ctrl+P 

New 

Edit 

Delete 

Ma k e Item Inactive

  

Hie r archical Vie w 

Flat View 

Customi se Columns.... 

Show Inacti v e Item s Show Inacti v e Item s 

For stock parts, the On Hand

column shows how many of

each item you have in stock.

Click the Item button to add

new items or perform 

activities on existing items.
2

Click the Custom Fields button

to set up and !ll in custom 

!elds that you need for your

items.

Enter the amount you want to 

charge for the item here.

Associate the item with an 

account here.

Choose the appropriate VAT

code here.

6

7

8
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Adding Items
In QuickBooks, an item is anything that your company 
buys, sells, or resells to run your business. Items are 
your products, services, and things such as shipping and 
handling charges, discounts, and VAT.

When you choose an item from the Item list, QuickBooks 
" lls in a description of the line item and calculates its 
amount for you.

QuickBooks provides 12 different types of items, described 
in the table on page 56. Some items, such as service or 
stock part items, help you record the services and products 
your business sells. Other items, such as the subtotal or 
discount item, are used to perform calculations on the 
amounts in a sale.

To add an item:

➊ Go to the Lists menu and click Item List.

➋ Click Item at the bottom of the list and then click New.

➌ Click the Type drop-down arrow and choose the type of 
item you want to create. (See table on page 56.)

➍ Enter an item name as you want it to appear on 
purchase and sales forms.

➎ Enter the description that you want to appear on sales 
forms when you use the payment item.

➏ In the Rate field, enter the amount you want to charge 
for the item.

➐ In the Account field, choose the account that is 
associated with this item. (In most cases, you will 
assign the item to an income account.)

➑ In the Tax Code list, select the appropriate VAT code or 
create a new one. If you do not see the Tax Code list, 
you must turn the tax preference on in the VAT area 
under Edit | Preferences.

➒ Click OK or Next (if you want to enter another item).

Items

An item is anything 

that might appear as a 

line item on an invoice, 

including subtotals, 

discounts, and VAT, as 

well as the products 

and/or services that you 

sell. You enter items on 

your invoices and sales 

receipts. For example, a 

writing consultant might 

set up one item for editing 

services with an hourly 

rate, and another item 

for writing services with a 

different hourly rate. On an 

invoice, the items would be 

entered with the number 

of hours worked as the 

quantity.

While providing a quick 

means of data entry, items 

also handle the behind-the-

scenes accounting. When 

you create an item you 

link it to an account. When 

the item is used on a form 

it posts an entry to that 

account and another to 

the appropriate accounts 

receivable, accounts 

payable, current, or other 

account.

Key Term
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Which Item Type Should I Choose?

QuickBooks provides 12 different types of items to help you " ll out sales and purchase 
forms quickly.

Item Type Purpose

Service
Use for services you either charge for or purchase, like specialised labour, 
consulting hours, and professional fees.

Stock part Use for goods you purchase, track as stock, and resell.

Stock assembly 
(Premier only)

Use for assembled goods you build or purchase, track as stock, and 
resell.

Non-stock part
Use for goods you buy but don’t track, like of" ce supplies, or materials 
you buy for a speci" c job that you charge back to your customer.

Fixed asset

Use for an asset you do not expect to convert to cash during one year of 
normal operations. A " xed asset is usually something that is necessary 
for the operation of your business—like a truck, cash register, or 
computer.

Other charge
Use for miscellaneous labour, material, or part charges, such as delivery 
charges, setup fees, and service charges.

Subtotal
Liabilities, such as loans or mortgages, scheduled to be paid over periods 
longer than one year.

Group
Owner’s equity, including capital investment, owner’s drawings, and 
retained earnings.

Discount
Use to subtract a percentage or " xed amount from a total or subtotal. Do 
not use this item type for an early payment discount; for an early payment 
discount, use the Set Discount feature in the Receive Payments window.

Payment
Use to record a partial payment you received at the time of the sale. It 
reduces the amount owed on an invoice.

VAT item
Use to calculate a single VAT at a speci" c rate that you pay to a single tax 
agency, for either sales or purchases (not both).

VAT group
Use to calculate and individually track two or more VAT items that apply to 
the same sale. The customer sees only the total VAT.
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Why item types are important

Although you can use items as a quick means of entering data, items ful" ll a much more 
important QuickBooks role: to handle the behind-the-scenes accounting. 

When you create an item, you link it to an account; when the item is used on a form, it 
posts an entry to that account and another entry to the appropriate accounts receivable, 
accounts payable, current, " xed asset, or other account.

While items are easy to set up, you should spend some time deciding how they can best 
work for you before you start setting them up and using them. Use your current list of 
services and products as a starting point. Consider how much detail you want on your 
invoices or statements and set up your items with that level of detail in mind. For example, 
if you are a seamstress who creates and sells home accessories, you can set up a single 
item and charge a % at rate for a certain size of couch pillow, or you can break that pillow 
down further into labour and materials.

Furthermore, QuickBooks provides many useful reports that break information down by the 
goods or services you purchase and sell. That way, you can quickly " nd out:

• How much income your items bring in 

• What you are spending to purchase items 

• How well you estimate the cost of items 

• How much time you spent on each type of job or item
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How VAT tracking works in QuickBooks

Assign VAT codes 
to your items.

Fill in your VAT return, and send 
your payment to the HMRC

QuickBooks tracks your output tax and 
input tax in the VAT Liability account, 

which QuickBooks 
creates by 
default.

QuickBooks calculates your VAT liability 
and numbers for the VAT 100 Return. 
The steps to remit your VAT depend on 
which VAT scheme you follow (Cash or 
Accrual reporting).

Sell items.

Invoice

Buy items.

Enter Bills
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Tracking VAT
If you are registered to collect VAT, you need to enable VAT tracking in QuickBooks. 
QuickBooks then tracks the VAT that your company pays on expenses, reclaiming it from the 
VAT that you collect and pay to HMRC.

QuickBooks supports the two most common VAT schemes: Standard Accrual VAT Accounting 
and Cash VAT Accounting.

• Standard Accrual VAT Accounting scheme: You track VAT on sales and purchases when you 
send an invoice or receive a bill, and very likely before you have received any money for 
these transactions from your customers.

• Cash VAT Accounting scheme: where you pay and reclaim VAT only on the basis of cash 
received and cash paid out by you. This scheme is meant to help smaller businesses with 
their cash % ow. To qualify, your annual turnover must be below a certain value.

Important: You must follow the rules and regulations for collecting and paying VAT from HMRC.

Understanding how VAT works in QuickBooks

You use VAT codes on transaction forms to set how VAT applies to the products and services 
that you buy and sell. For example, when you create an invoice, you assign an appropriate 
VAT code to each line item on the invoice.

Each VAT code is associated with one or both of a VAT item for sales, and a different VAT 
item for purchases. This lets QuickBooks properly track both output tax (from your sales) 
and input tax (from your purchases).

QuickBooks uses VAT items to calculate and add VAT charges when you make a taxable 
sale. When you set up a VAT item, you assign a VAT rate to it and associate it with the tax 
agency to which you pay the VAT (typically HMRC). All of the VAT items you set up are in your 
Item list. After you enable and set up VAT, QuickBooks applies the appropriate VAT rate to 
the sale of your taxable items, based on the VAT code.

Tip  QuickBooks sets up default VAT codes, VAT items, and your VAT agencies for you. 
These become available when you enable VAT, either from the EasyStep interview or 
through the Preferences window.
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Preferences: Set VAT preferences

Verify that you have VAT

turned on.

Choose what VAT scheme you

are registered for.
5

4

Choose the VAT codes that

you want to use as the preset 

codes on all of your sales

forms (invoices, sales

receipts, etc.).
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Setting up VAT

If you need to make changes to how VAT is con" gured, you need to know the following:

• VAT rates and schedules for the new tax situation that you need to handle.

• Tax agencies to which you pay the collected VAT. Typically, this is HMRC.

Setting up VAT is a multi-step process, divided into three main parts:

• Part 1: Enable VAT in preferences

• Part 2: Setting your VAT schedule

• Part 3: Entering an opening balance for VAT liability

Don’t forget to specify your VAT Registration number in the Company Information window. 
(Go to the Company menu and click Company Information.)

Tip  QuickBooks 2008 includes a new Manage VAT window to help you complete your 
common VAT tasks, like setting VAT preferences and " ling VAT. To open this window, go 
to the VAT menu and then click Manage VAT.

Enabling VAT in preferences

In this procedure, you’ll turn on VAT and then set up basic information about how you report 
VAT to your tax agency.

To set up your VAT payment schedule:

➊ Go to the Edit menu and click Preferences. 

➋ Click VAT in the list on the left.

➌ Click the Company Preferences tab. 

➍ For the question Do You Charge VAT?, click Yes.

➎ For the question When do you owe VAT?, select when you owe VAT to the tax agency, as 
specified by your tax agency.

• Select As of invoice date if you are using the standard (accrual) VAT accounting 
scheme. This speci" es that you owe VAT from the moment you write an invoice or 
make a sale.

• Select Upon receipt of payment if you are using a VAT cash accounting scheme. This 
speci" es that you owe VAT when you receive the payment from a customer.

Note: This preference is separate from the accounting basis you’ve set for your company and for 

your report preferences (i.e., if your Reports & Graphs preference is set to “cash” but you select 

“accrual” here, your VAT reports will be accrual-based).
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Part 2: Setting your VAT reporting periods

Your VAT reporting periods are when and how often you need to " le VAT with HMRC. You 
set this up in the HMRC VAT supplier (the VAT agency’s supplier record). While QuickBooks 
creates the supplier record for you, you still have to specify the VAT schedule yourself.

To set up your VAT items, rates, and tax agencies:

➊ Open the Supplier Centre (go to the Suppliers menu and click Supplier Centre).

➋ In the lists on the left side of the screen, click the Suppliers tab.

➌ Double-click the supplier used to pay VAT. Typically, this is “HMRC VAT”.

Note: If you’re using a new company that you created with QuickBooks 2008, do not double-click the 

“HM Revenue & Customs” supplier. That supplier is used when running payroll.

➍ In the Edit Supplier window, click the VAT Agency Info tab.

➎ In Period and Period Ending, select the schedule at which you file VAT. For example, if you 
file VAT four times a year at the end of January, April, July, and October, choose a Period 
of “Quarterly” and a Period Ending of “Apr/Jul/Oct/Jan”.

➏ Click OK to close the Edit Supplier window. 

Part 3: Entering an opening balance for VAT liability (what you owe)

You need to enter an opening balance for your VAT Liability account (what you owe as of your 
QuickBooks start date). After your start date, your VAT is included on your sales forms and 
entered into this account.

Caution Do not do this if you entered all historical invoices or sales receipts dated 
before your QuickBooks start date. Your VAT will already be included on them and 
posted to this account.

To enter your VAT liability:

➊ Go to the VAT menu and click Adjust VAT Due.

➋ In VAT Agency, select the VAT agency (typically “HMRC VAT”).

➌ In VAT Item, select one of the following:

• If you owe money to the VAT agency, select “Standard Sales”. 

• If you are owed money by the VAT agency, select “Standard Purchases”.

➍ In Adjustment Account, select “Opening Bal Equity”.

➎ In Amount, enter the amount of VAT that you owe or that was owed to you as of your 
QuickBooks start date. Select Increase VAT line or Decrease VAT line, as appropriate.

➏ Click OK.
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Default VAT codes

When you enable VAT, QuickBooks sets up the following VAT codes by default. In most cases, 
these will be all you’ll need.

VAT code Description

S
Standard VAT rate. Use for services or goods that are taxable at the 
standard VAT rate. As of 2007, the standard VAT rate set by HMRC is 
17.5%.

E
Tax exempt. Use for services or goods that are exempt from paying VAT, 
such as postal rates or medical care.

Z

Zero-rated. Use for services or goods that are zero-rated. Zero-rated items 
have a 0% tax rate, but are still considered taxable.

A zero-rated item is distinct from a tax exempt item. If you sell services 
that HMRC considers zero-rated, but paid standard VAT on equipment used 
to produce those services (your input tax), you can still recover the VAT 
that you paid. If HMRC instead considers those services to be tax exempt, 
you cannot recover your input tax.

R
Reduced VAT rate. Use for services or goods that are taxable at the 
reduced VAT rate. As of 2007, the reduced VAT rate set by HMRC is 5%.

EGS, EGZ

EC Goods Standard and EC Goods Zero-rated. Use for goods that are 
bought and/or sold from outside the country, but still within the European 
Community (EC). Use this code only if you have your customer or supplier’s 
VAT registration number.

RC

Reverse Charge (Carousel/MTIC). Use for supplies of mobile phones and/
or computer chips that are valued at £5,000 or over and are sold by one 
VAT-registered business to another on or after 1 June 2007. You must 
add the following memo to Invoices you create that contain the RC code: 
"Customer to pay output tax of £X to HMRC".

O
Outside the scope of VAT. Use for items that fall outside the scope of the 
VAT system.

N Not rated. The item is not rated for VAT.

Tip  HM Revenue & Customs has very speci" c rules that set the VAT rate for different 
types of goods and services. If you’re not sure what VAT code to apply to an item, you 
can " nd out from the HM Revenue & Customs web site at http://www.hmrc.gov.uk.
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File VAT window

Click Adjust VAT Return to 
make an adjustment to a 
line in the return.

The VAT amounts for each 
line in your VAT return are 
displayed here.

Click File VAT Return to " le 
your VAT and adjust your 
accounts in QuickBooks.

Click Print VAT Return to 
print a copy of the VAT 
return. You can use this 
printed copy to " ll out the 
personalised form you got 
from HMRC.
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Did You Know?
Filing VAT

When it’s time to pay your VAT, you may want to review the 
VAT 100 report. (Go to the VAT menu and then click VAT 
100.) Then, use the File VAT window to " le and pay your VAT 
in QuickBooks and create and pay your VAT bill. You can 
transfer the information to your printed form from HMRC.

Important:  Do not pay your VAT using the Write Cheques or Pay Bills 

window. This will cause errors in your bookkeeping and in your VAT 

reports.

To ! le your VAT return:

➊ Go to the VAT menu and click File VAT.

➋ In the VAT Agency field, select your VAT agency (typically 
HMRC VAT).

➌ Check the dates of the VAT period and your balance 
owing or receivable at the bottom of the File VAT window.

➍ If you need to make an adjustment, click Adjust 
VAT Return and enter the needed adjustment to the 
appropriate box on your return.

➎ When you’re confident that the values are complete and 
accurate, click File VAT Return.

➏ Optionally, print a copy of the QuickBooks VAT Return for 
your own records.

➐ Do one of the following:

• If you owe money, QuickBooks creates a bill for the 
amount owed and opens the Payment window. You 
can pay the bill now, or later along with your other 
bills.

• If you are owed a refund, QuickBooks creates a 
receivable amount for the amount and opens the 
Refund window. You can receive the payment now, or 
later when you receive the cheque from HMRC.

➑ Use the information in the File VAT window to fill out your 
personalised HMRC VAT return or the HMRC online filing 
website.

Note:  If you owe a VAT payment, don’t forget to include the 

payment when you mail your VAT return.

For more details, see the in-product Help.

Manage VAT window

QuickBooks 2008 includes 

a Manage VAT window to 

help you complete common 

VAT tasks, like setting VAT 

preferences, and " ling VAT. 

Go to the VAT menu and 

then click Manage VAT to 

open this window.

How do I fi le my VAT if I’m 

tracking VAT on a cash 

basis?

In QuickBooks 2008, the 

process for preparing and 

" ling your cash based VAT 

Return is the same as for 

Accruals basis. You must 

use the File VAT menu 

described on this page.
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Pay Employees: Run 
payroll and perform 
ongoing payroll activities 
from this section.

Click to switch between 
your Employees list, 
Transactions, and Payroll 
Activities status.

Payroll Forms: Print a 
P45 and process year 
end in this section.

Liabilities: Track and pay 
your payroll liabilities or 
make adjustments in this 
section.

Payroll Centre

Payroll Setup: Set up 
payroll from this section.
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Did You Know?
Setting up your Payroll 

Paying employees is a big responsibility. You have to 
calculate gross and net pay, tax, NICs, statutory payments 
and pension scheme deductions, as well as track the 
liability payments you need to send to your tax of" ce and 
bene" t agencies.

Using the QuickBooks Payroll service

With a subscription to QuickBooks Payroll, you have access 
to several features and services to help you process your 
payroll without having to understand payroll legislation. 
No more manual calculations, or having to keep track of 
changes that are made to the tax tables. QuickBooks takes 
care of your payroll so you have more time to spend on your 
business.

You can learn about the QuickBooks payroll service through 
the QuickBooks Payroll Web site.

To learn about and sign up for QuickBooks Payroll:

• Go to the Employees menu, click Payroll and then click  
click About Payroll Service.

Or, contact one of our payroll experts at 0845 606 2161 
(outside the UK, +44 870 609 0601).

Note: If you choose to sign up for QuickBooks Payroll, you will be 

prompted to complete the activation process for your service. After 

you subscribe to QuickBooks Payroll, you can begin setting up payroll 

for your business.

Setting up QuickBooks Payroll 

QuickBooks includes step-by-step instructions that take 
you through setting up payroll for your business. You need 
to set up your payroll items, your employees, and set your 
employees’ year-to-date (YTD) amounts.

Depending on the size of your company, payroll setup 
can take a long time to complete. Before you begin 
setting up payroll, we recommend you gather all of the 
information in the Payroll Setup Checklist on page 69. 

To set up payroll for your business:

➊ Go to the Employees menu and click Payroll Learning 
Centre.

➋ Click the link “Setting up and managing the basics”.

Using QuickBooks with 

another payroll service

If you plan to use an 

outsourced payroll service, 

do not set up payroll in 

QuickBooks. Instead, do 

the following:

• Add your employees to 

the Employee list in the 

Employee Centre

• Decide how much payroll 

detail you will track in 

QuickBooks so that your 

statements and balance 

sheets will be accurate.

• Set up an expense 

account for payroll 

expenses, with sub 

accounts for each type of 

expense (such as income 

taxes or NI deductions).

• Set up an Other Current 

Liability account for 

all employee-paid 

deductions paid later 

than the payroll date.

• When you get information 

from the payroll service, 

enter employee payroll 

payments in the Write 

Cheques window (go to 

the Banking menu, and 

click Write Cheques).

• Assign an expense 

account for the portion 

of the payment that is 

a company expense. 

Enter a separate line 

for the portion that the 

employees paid for as 

deductions. Use your 

Payroll Liabilities account 

for the deductions.

For more details see the 

in-product Help.
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➌ Follow the instructions in the help topic that appears, following the links as needed. 
In general, you will create the payroll items you need, set up your employees, and then 
enter your employees’ year-to-date amounts.

The following sections describe common activities you will perform during payroll setup.

Setting up Payroll Items

You add payroll items to payroll payments the same way you add items to invoices. Payroll 
items track amounts such as wages you pay and taxes you deduct from your employees’ 
payroll payments. There are payroll items for commission, taxes, NICs, other additions and 
deductions, and employer-paid expenses. You can assign these payroll items to different 
accounts as needed.

By default, QuickBooks creates common payroll items that you’ll need, such as statutory 
payments, tax deductions, pension schemes, AEOs, and student loan repayments. However, 
you may need to add other payroll items for your own company, such as for health insurance 
that your company provides to employees.

To create a payroll item:

➊ From the Employees menu, click Payroll Setup, and then click Add or Edit Payroll Item 
List.

➋ From the Payroll Item menu button, choose New. The payroll item wizard opens.

➌ Choose the type of payroll item you want to create and click Next:

Wage: Money you pay to employees for salaries, hourly wages, and commissions.

Addition: Money you pay to employees above his or her base earnings, such as a bonus.

Deduction: Money you deduct from your employee other than taxes, such as pensions

Employer Contribution: Employer-paid bene" ts for your employees, such as life insurance 
or employer contributions to a pension scheme.

Attachment of Earnings Order (AOE): Money that a court or local authority orders you to 
deduct from an employee to pay back his or her debt.

➍ Follow the onscreen instructions. When you’re done, click Finish.
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Entering year-to-date amounts for your employees

If you begin using QuickBooks Payroll part way through the current tax year, you must enter 
year-to-date amounts for each employee that you’ve paid thus far in the tax year. PAYE is 
calculated on a cumulative basis, so QuickBooks needs to take into account an employee’s 
total pay and tax amounts for a given tax year in order to be able to deduct the right amount 
of tax from his or her pay.

You can use the Year-to-Date wizard to help you enter year-to-date amounts for your 
employees.

Note: If you have an employee who begins working for you part way through the tax year, do not use the 

Year-to-Date wizard to add employment fi gures from his or her previous employer. Instead, add the fi gures 

from the P45 to his or her employee profi le. (With the employee profi le (record) open, go to the Employment 

Info tab and click the Previous Employment button.)

To enter year-to-date amounts for each employee:

Summarise the payroll payments you processed for each employee from 6 April to the date 
that you started using QuickBooks Payroll.

➊ From the Employees menu, click Payroll Setup then choose Set Up YTD Amounts. The 
YTD wizard opens.

➋ Follow the on-screen instructions until you get to the Employee summary information 
screen. Select an employee from the list and click Enter Summary. The YTD Adjustment 
window opens.

➌ Enter the details of the year-to-date payroll amounts for this employee. We recommend 
that you create one entry to summarise the payroll payments that you’ve paid to this 
employee thus far. You cannot do this, however, if an employee’s NI code changed 
throughout the tax year. An entry must be created for each payroll period where a new NI 
code was given.

➍ Click OK, and select the next employee.

➎ Click Finish when you are done, or if you need to enter prior payroll liability payments, 
click Next and refer to the steps below.

To learn more about entering year-to-date amounts, see the in--product Help.

To enter prior payroll liability payments:

➊ Open the YTD wizard as explained in the steps above.

➋ Follow the on-screen instructions until you get to the Enter prior payments screen.

➌ On the last screen, click the Create Payment button to enter a summary of all the 
payments you’ve made to the government and other agencies from 6 April to the date 
you subscribed to QuickBooks Payroll.
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Payroll Setup Checklist

Before you begin setting up payroll, you should gather the following information. You can 
" nd this information in your own records, from your accountant or QuickBooks ProAdvisor, or 
from government agencies.

Information QuickBooks needs Where to ! nd it

Tax of! ce number and reference
P11 Working Sheet, your accountant or 
company records

Current tax tables covering payroll withholdings 
such as National Insurance Contributions and 
income tax rates

QuickBooks downloads them automatically for 
you while you are subscribed to QuickBooks 
Payroll.

How you pay your employees and directors 
(hourly wages, salaries, and/or commissions

P11 Working Sheet, your accountant, or 
company records

How often you pay your employees
P11 Working Sheet, your accountant, or 
company records

Additions you make to your employees’ pay 
that increases their earnings base (bonus 
payments, statutory payments, etc.)

P11 Working Sheet, your accountant, or 
company records

Deductions you make to your employees’ pay 
(pension schemes, student loan repayments, 
union dues, holiday pay schemes, Attachment 
of Earnings Orders, etc.)

P11 Working Sheet, your accountant, or 
company records

Payroll expenses that your company pays 
(employee pension schemes, health or life 
insurance)

P11 Working Sheet, your accountant, or 
company records

Information for company directors. Do you 
calculate NICs based on the annual (or pro-
rate annual) method or per period (weekly, 
monthly)?

P11 Working Sheet, company records, 
employee, payslips, employee contracts

Employee personal information (National 
Insurance number, date of birth, contact 
details)

P11 Working Sheet, your employee, or 
company records

Employees’ rate of pay and payroll payment 
additions, deductions, and employer 
contribution amounts

Payslips, company records, employee 
contracts, or your accountant

Previous employment information for 
employees who joined your company mid-
way through the current tax year (National 
Insurance, tax codes and Scheme Contracting 
Out Number (SCON) for employees who opted 
out of State Earnings Related Pension Scheme 
(SERPS))

P45 or P46, SSP1(L), previous employer, your 
accountant or company records
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Information QuickBooks needs Where to ! nd it

If paying by BACs, employee’s bank or building 
society details (sort code, account number, 
name of account holder, bank name and 
address, and roll number if the account is with 
a building society)

Employees, your accountant, or company 
records

Statutory payment information for existing or 
future SSP, SMP, SPP, or SAP, including working 
day patterns

SSP1(L), BF 220/220A/220B/220C, MATB1, 
your accountant or company records 

Holiday and sick time accruing policies and 
amounts

Payslips, your accountant, or company records

Total employee payroll amounts that you’ve 
paid out so far this payroll year up to the date 
you start using QuickBooks, including amounts 
withheld from payroll payments, commissions, 
and bonuses

Copies of employee payroll payments, payslips, 
previous accounting software or service 
provider, reports, your accountant or company 
records 

If you are already operating payroll, total 
amount of PAYE income tax and National 
Insurance (NI) contributions are owed to the 
HMRC as of your start date. 

Previous accounting software or service 
provider, accountant or company records 

Processing Your Year End

After running your " nal payroll period for the year, you can work through your year end quickly 
and easily with the Payroll End Year Process window. It will guide you through the steps you 
must complete when processing your payroll year end, and help you produce the year end 
forms that you need to submit for your employer’s annual return. 

To use the Payroll Year End Process window:

➊ Go to the Employees menu, choose Payroll Forms, and then choose Process Payroll Year 
End.

➋ Starting with Review P14/P60 Data, click the button for each task and follow the 
onscreen instructions.

For more details, click the Help button on the Payroll End Year Process window to view the 
in-product help. 
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x

Information for: Douglas Begle 

Change tabs: 

Payroll Info 

Earnings 

Item Name 

Item Name Amount Limit Tax & NI...

Payroll 

R egular  P a y 75.00 

Use time data to create p a yroll payments

Additions, Deductions and Compa n y Contribution s 

Hourly/Annual R at e 

P a yroll and Compensation Inf o 

Fortnightly

OK 

Cancel 

Next 

Help 

Empl o y ee i s 
inacti v e 

Type a help question Ask How Do I? Edit Employee 

Sick/ Holiday...

Bank Details...

x

Information for: Douglas Begle 

Doug Begle 

123-45-6789 

06/12/1984

Address and Contact Additional Info 

Legal Name 

First Name M.I. 

Last Name 

Print as

M r ./Ms./.. . M r . 

Douglas 

Begle 

NI No.

Male Gender

Date of Birth

Personal 

Change tabs: 

OK 

Cancel 

Next 

Help 

Empl o y ee i s 
inacti v e 

Type a help question Ask How Do I? New Employee 

P ersonal Inf o 

Marital Status

New Employee: Personal Tab

Edit Employee: Payroll Info

Enter the employee’s personal

information, including their

NI number and the name to

be printed on their payroll

payments.

Enter the employee’s address

and contact information in the

Address and Contact tab.

If paying by BACS, enter the

employee’s bank account

information.

 

 

 

Enter employee bene!ts and

deductions.

Set up the employee’s tax and

NI information.

 

Enter how much sick and

holiday time the employee has

accrued and used thus far.

Enter employee basic earnings

information. Schedule

WeeklyPay Frequency

ChequePay Method

Select a payroll schedule that

you have set up (see page 89).
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Setting up Employees
To process payroll payments and prepare tax documents 
for your employees, you need to enter speci" c information 
about each of your employees in QuickBooks.

Refer to the Payroll Setup Checklist on page 69 for a list of 
employee information to gather.

To set up an employee’s personal information: 

➊ Click the Employee Centre icon at the top of the 
QuickBooks window.

➋ Click New Employee.

➌ On the Personal tab, fill in the form.

➍ Click the Address and Contact tab, fill in the form, and 
then click OK.

➎ When prompted to set up the employee’s payroll 
information, click Leave As Is. Or, continue with the 
instructions below.

To set up an employee’s payroll information:

➊ Click the Employee Centre icon at the top of the 
QuickBooks window.

➋ Click the Employees tab and then double-click the 
employee’s name.

➌ From the Change tabs drop-down list, click Payroll and 
Compensation Info.

➍ Fill in the Payroll Info form.

➎ Click the Tax & NI Details button. Fill in the form, based 
on the employee’s tax and NI information.

➏ Click the Sick & Holiday button. Fill in the form to specify 
how sick time and holidays are accrued.

➐ If you pay the employee with BACS, click the Bank 
Details button to set up the employee’s bank account 
information.

➑ Click OK.

Once you’ve set up your employees, refer to “Paying 
Employees” on page 89 to learn about paying them.

Earnings base

An earnings basis is the 

wages or earnings due to 

an employee before any 

deductions are made. It is 

also referred to as gross 

pay, taxable income, or 

(for NI purposes) insurable 

or NI-able earnings. An 

employee’s earnings 

base can include wages, 

salaries, overtime, 

bonuses, and commission. 

QuickBooks uses the 

earnings base to work 

out payroll withholding 

amounts, such as income 

tax or National Insurance 

contributions. 

Key Term

Directors

A director is a person who, 

traditionally, manages the 

business of the company 

on a day-to-day basis. With 

QuickBooks, you have the 

% exibility to calculate your 

director’s NICs annually or 

on a per period basis.

For more information on 

directors, refer to the in-

product Help. 

Key Term
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Create Estimates 

Choose the Estimate template 

you want to use, or create 

your own.

Choose items to add to the 

estimate or create new items.
5

Print and mail or e-mail 

estimates to your customer.
6

 When you’re ready to bill the 

 customer, click here to convert 

 this estimate to an invoice.

4
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Creating an Estimate
You can use the estimate form to prepare estimates, bids, quotes, or proposals for your 
customers. You can change the title “Estimate” to anything that suits your business.

Filling in the estimate is similar to creating an invoice. And when it’s time to bill your 
customer, you can create the invoice directly from the estimate by clicking Create Invoice on 
the estimate’s toolbar. QuickBooks then creates the invoice, with all the information from 
the estimate " lled in. Later, you can create reports that compare your estimated costs and 
revenue against your actual costs and revenue to see how accurate your estimates are.

To create an estimate:

➊ If necessary, turn on Estimates (described below), if you didn’t do this during the 
EasyStep Interview.

➋ Go to the Customers menu and click Create Estimates.

➌ Enter the name of the customer or job.

➍ Select an estimate template from the Template drop-down list.

➎ Fill in the estimate form.

➏ Click Print.

❼ Save the estimate.

To turn on the estimates feature:

➊ Go to the Edit menu and click Preferences. 

➋ Click Jobs & Estimates in the list on the left and then click the Company Preferences tab. 

➌ Click Yes to the question, “Do You Create Estimates?” 

➍ To have QuickBooks warn you when you try to record an estimate with the same number 
as the existing estimate, select the Warn about duplicate estimates numbers checkbox.

➎ If you do progress invoicing:

• Make sure Yes is selected in response to the question, “Do You Do Progress 
Invoicing?”

• Specify whether you want line items that have zero amounts to print on your progress 
invoice

➏ Click OK.
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Create Invoices

  
 

3

Choose the Invoice template 

you want to use or create 

your own.

5Choose items to add to the 

invoice or create new items.

6
Print and mail or e-mail 

invoices to your customer.

Create Custom Invoices  

Print your company logo on 

your invoice.

Choose different fonts to 

use for different parts of 

the invoice.

Click here to access more

advanced customisation 

options.

Control what type of 

information gets printed 

on your invoices.
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Key Term
Creating an Invoice
When your customers don’t pay you in full at the time 
you provide your service or product, or when they pay in 
advance, you need to track how much they owe you. You 
can use an invoice to help you keep track of what your 
customers owe you (or your “accounts receivable”).

Invoices list all the details about the sale, including the 
services you’re providing or the products you’re selling (your 
“items”). Invoices also show the quantity and price or rate 
of each item. If you need to make automatic adjustments 
to prices (for example, discounts or markups), invoices will 
work for you.

Note: If your customers pay in full at the time of purchase, do not 

create an invoice. Instead, create a sales receipt, described on page 

77.

To create an invoice:

➊ Go to the Customers menu and click Create Invoices.

➋  Enter or choose in the Customer:Job drop-down list, click 
the name of the customer or job.

➌ Click the Template drop-down arrow and then click the 
invoice template you want to use.

➍ Click the Terms drop-down arrow and then click the sales 
terms that apply to this customer.

➎ In the lower part of the form, enter each of the items 
(including the proper quantity) that the customer has 
purchased.

➏ Click Print on the toolbar to print the invoice now. 
Optionally, you can select the To be printed checkbox to 
print the form later.

➐ Save the invoice.

Tip: You can customise your invoices (or any other 
sales form) for your business. Click Customise to 
open the Basic Customisation window, where you can 
add your company logo, change fonts and colours, and 
access more advanced options.

Estimate

An estimate is a form you 

use to itemise the work 

you propose to do or the 

products you intend to 

sell to a customer. Your 

company might use a 

different term, such as 

bid, grant, or proposal. 

Estimates are optional, 

not mandatory, for all 

businesses.

Did You Know?

Using sales orders

In QuickBooks Premier, you 

can create sales orders 

to help you keep track of 

items that your customers 

have ordered but you have 

not yet delivered to them, 

for example because you 

do not have them in stock.

Refer to the in-product 

Help for instructions and 

tips on how to use sales 

orders.
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Sales Receipt

Choose items to add to the 

Sales Receipt or create new 

items.

4

 

Choose the Sales Receipts

template you want to use or 

create your own. 3
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Key Term
Entering Sales Receipts
When your customers pay in full at the time they receive 
your service or product, you don’t need to track how much 
they owe you. However, you might want to record the sale, 
calculate its VAT, or print a receipt for the sale. In these 
cases, you can create a sales receipt.

Examples of businesses that commonly use sales receipts 
include hairdressers, beauty salons, and DIY shops.

Note: If you need to track how much a customer owes you or you do 

not receive full payment at the time of the transaction, do not use a 

sales receipt. Instead, create an invoice, described on page 75.

To enter a sales receipt:

➊ Go to the Customers menu and click Enter Sales 
Receipts.

➋ Fill in the top part of the form, including the 
Customer:Job, Date, and Payment Method.

➌ Click the Template drop-down arrow and then click the 
sales receipt template you want to use.

➍ In the bottom part of the form, select or enter the items 
purchased.

➎ Save the transaction.

Invoice

An invoice is the form you 

use to charge customers 

for the products and 

services they purchase 

from you.

Did You Know?

You can create an invoice 

letter directly from the 

invoice form by clicking 

the Letters button on the 

Create Invoices toolbar. 

Refer to the in-product 

Help for more detailed 

information about this 

feature.
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x 

Previous Next History Journal 

Clear S a v e & Clos e 

Type a help question Ask How Do I? Receive Payments 

Save & New 

Date  

R ecei v ed Fro m Customer Balance: 

Date 

Un - Apply  P a ymen t 
Amount Due

Applied 

Discount and Credits 
Applied 

Discount & Credits... 

14/07/2007

1,040.00 

Customer Payment 

2112 Cheque #

Ba k e r , Chri s 

Cheque

1,040.00 Amount 

Pmt. Method 

Memo 

Number Orig. Amt. Amt. Due P a ymen t 

Find a Customer/I n v oice.. . 

T otal s 

15/12/2007 74 1,040.00 1,040.00 

30/12/2007 77 2,000.00 2,000.00 

1,040.00 

3,040.00 3,040.00 1,040.00 

1,040.00 

1,040.00 

0.00 

Receive Payments

2
Choose a customer from the

drop-down list.

 
3The checkmark next to the 

invoice tells QuickBooks to 

apply the payment to this

invoice.

 

 
Amounts for Selected Invoices 
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Receiving a Payment 
When you receive money from a customer, you must receive 
the payment in QuickBooks so QuickBooks can record the 
transaction and mark the invoice as being paid. When you 
receive a payment, the accounts receivable records are 
updated, and the payment is ready to be deposited into an 
account.

To receive a payment:

➊ Go to the Customers menu and click Receive Payments.

➋ Fill in the top portion of the form, including the 
customer’s name, the payment amount, payment 
method, and the date on which the payment was 
received.

➌ Check the column to the left of the invoice to which 
you want to apply the payment. You might be asked to 
decide how to apply the payment for one of the following 
scenarios:

• Overpayment can become a credit or refund

• Underpayment can be left as is or written off

• Customer has unused credit to be applied

• Customer has available discounts

➍ Choose the appropriate selection and you should see 
your choices reflected in total amounts for selected 
invoices.

If the customer has a discount or available credits, you 
can choose how to apply them.

➎ Save the payment.

Key Term

Sales Receipt

A sales receipt is the form 

you use when you make a 

sale for which you receive 

full payment at the time of 

the sale. Sales receipts 

can include payments by 

cash, cheque, or credit 

card.

Did You Know?

You can also use a 

sales receipt to create a 

summary of sales income 

and VAT owed. You can 

summarise daily or weekly 

sales on a sales receipt.
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x

Previous Next Print Payments Journal

Received From From Account Memo Chk No. Pmt Meth. Amount

Baker, Chris Undeposited Funds 2112 Cheque

To get cash back from this deposit, enter the amount below. Indicate the account
where you want this money to go, such as your Petty Cash account.

 Cash back goes to  Cash back memo  Cash back amount

Deposit Subtotal

Deposit Total 1,040.00

1,040.00

ClearSave & Close

1,040.00

Click Payments to select customer payments that you have received. List any other amounts to deposit below.

Type a help question Ask How Do I?Make Deposits

Deposit To Date Memo Deposit14/07/2004Checking

Save & New

xPayments to Deposit Type a help question

Select View

Date

14/07/2004
11/04/2007
10/09/2007
23/09/2007
26/09/2007
30/10/2007
25/11/2007
14/12/2007
15/12/2007
15/12/2007

PMT
PMT
PMT
PMT
PMT
PMT
PMT
PMT
LIAB ADJ
PMT

2112
3402
5668
2957
1556
41022
15785
986

Cheque
Cheque
Cheque
Cheque
Cheque
Cheque
Cheque
v

Cash

1,040.00
5,164.00
2,481.80
2,400.00
2,400.00

16,537.54
5,435.00
2,000.00

124.00
440.00

Baker, Chris
Fisher, Jennifer
Luke, Noelani:Kitchen
Dunn, Eric C. W.:Utility...
Johnson, Gordon:Utility...
Memeo, Jeanette
Pretell Real Estate:155...
Jacobsen, Doug:Kitchen
Great Statewide Bank
Roche, Diarmuid:Garag...

Time Type No. Payment Method Name Amount

View payment method type

Select Payments to Deposit

All types What are payment method views?

OK

Payments Subtotal0 of 10 payments selected for deposit 0.00

Cancel Help

Select All Select NoneSelect None

Ask How Do I?

Get Funding Status

Payments to Deposit

Make Deposits

Click Payments to see other

payments you can deposit.

QuickBooks sorts received 

payments by payment method 

type.

2

3Indicates the account to 

which you want to deposit

the funds. 

5
Record cash back from a 

deposit by specifying the 

account and amount here.

The checkmark indicates 

which payments to deposit.
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Making a Deposit
When you receive a payment from a customer, you can 
either deposit the payment into a bank account immediately, 
or you can wait until a later time to make the deposit.

To make a deposit:

➊ Go to the Banking menu and click Make Deposits.

➋ In the Payments to Deposit window, select the payments 
that you want to deposit and click OK.

➌ In the Make Deposits window, click the Deposit To drop-
down arrow and then click the account to which you want 
to deposit the funds.

➍ Verify the date and the list of payments to deposit, 
making updates as necessary.

➎ If you want to receive cash back from this deposit, fill in 
the Cash Back fields at the bottom of the form.

➏ If you want to print a deposit slip or deposit summary, 
click Print.

➐ Save the deposit.

Note: Just because you’ve recorded the deposit in QuickBooks doesn’t 

mean that you’ve actually made the deposit and that the money is 

available. You still need to physically deposit the money at the bank.

You can set a preference 

so that payments received:

• Automatically go to 

the undeposited funds 

account

• Automatically get 

calculated and applied 

as you select invoices in 

the list 

Go to the Edit menu, click 

Preferences, and then click 

the Company Preferences 

tab in the Sales & 

Customers area to set this 

preference.

Did You Know?
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Money Out  |  Paying Bills

Enter Bills

Choose or enter the name 

of the supplier who sent you 

the bill. 2

Select the payment terms 

here and QuickBooks will

auto!ll the Bill Due date 

for you.

Enter the amount due here.

Assign the bill to one or more

expense accounts.

Pay Bills

Click here to display all 

unpaid bills or all bills that 

are due before a speci!c date. 2

The ticks indicate the bills

you’ve chosen to pay.
3

Click Go to Bill to view the 

bill that corresponds to the 

selected bill.

5

3
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Paying Bills
As you purchase equipment, supplies, products, or services 
to run your business, you will also receive bills that need 
to be paid. Entering these bills in QuickBooks enables you 
to not only track information about your purchases, but 
also to pay these bills. QuickBooks remembers all of your 
unpaid bills, enabling you to easily choose the bills you want 
to pay. QuickBooks then writes and saves the cheques or 
credit card charges or sends the online banking payment 
instructions, depending on the payment method you choose.

Note: Before paying a bill, be sure you read the section “Writing 

cheques versus paying bills” on page 39 to make sure you are using 

the correct payment method.

To enter a bill:

➊ Go to the Suppliers menu and click Enter Bills.

➋ In the Supplier field, choose or enter a new supplier.

Note: If an open purchase order exists for this supplier, you are 

prompted to receive against it. Click Yes to receive against one or 

more purchase orders; then, in the Open Purchase Orders window, 

click each purchase order that contains items you’ve received and 

are being billed for.

➌ In the Amount Due field, enter the amount of the bill.

➍ Fill in the Date, Ref. No., Terms, and Memo fields as 
necessary.

➎ For expenses (money you spend to run your business, 
such as utilities), assign the invoice to one or more 
expense accounts on the Expenses tab. 
For items (products or services your business buys), edit 
items that were entered from your purchase order or 
enter new items on the Items tab.

➏ Click Save & Close or Save & New to save the transaction.

To pay a bill:

➊ Go to the Suppliers menu and click Pay Bills.

➋ All outstanding bills are displayed. To limit the number of 
bills displayed, click Due on or before and then click the 
due date for the bills you want to display.

➌ Specify the Payment Account, Payment Method, and 
Payment Date.

➍ Click Pay Selected Bills to complete the transaction.

Do not use the Write 

Cheques window to write a 

payroll payment, pay your 

payroll liabilities, pay VAT, 

or pay bills you’ve already 

entered in the Pay Bills 

window.

Refer to the in-product 

Help for more information 

on how to make these 

types of payments.

Paying employees

Refer to page 89 for 

instructions on paying 

employees.

Paying bills

You don’t need to use 

the Pay Bills window to 

pay your bills. You can 

enter cheques, credit 

card payments, and cash 

expenditures directly in 

the appropriate account 

register. However, if you 

enter bills using either 

the Enter Bills window 

or the Accounts Payable 

register, you must use the 

Pay Bills window for your 

bill payment. Do not use 

the Write Cheques window 

to pay a bill that you’ve 

entered with either of 

these methods.

Did You Know?
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Money Out  |  Writing Cheques

Set to OK 

Cancel 

Help 

Select All 

Select None 

Bank Account 

Date 

15/12/2007
15/12/2007
15/12/2007

Daigle Lighting 
P erry Windows & Door s 
Sergeant Insu r anc e 

640.92 
6,935.75 

675.00 

196 

P a y e e Amount  

Select Cheques to print, then click OK,

There are 3 Cheques to print for £8,251.67.

Current Account First Cheque Number

xSelect Cheques to Print Type a help question Ask How Do I? 

x

Previous Next Print Find Journal 

P a y to the Order o f Gallion Masonry 

One thousand fi v e hundred fif t y and 00/100* * * * * * * * * * * * * * * * * * * * * * * * *  * 

Address 

Memo 

Expenses £1,550.00 Items £0.00 T o be printe d 

Memo Customer:Job Account 

Job Expenses: Job Materials 1,550.00 Ba k e r , Chri s 

Amount 

N o . 302 

1,550.00£

Dollars 

Clear Clear Splits R ecalculat e S a v e & Clos e 

7,178.06 

Type a help question Ask How Do I? Write Cheques - Current Account

Bank Account Ending Balance 

Date 14/07/2004

Current Account

Save & New 

Gallion Masonry 
189 Old B a yshore R d 
Twyford, Reading, Berkshire
RG10 9BF

Write Cheques

Select Cheques to Print

4
Click here to choose the

cheques you want to print.

Make sure that the cheques in

your printer correspond to the

cheque number entered here.

Use the Expenses tab to 

itemise purchases you make

to run your business, such as

job materials or utility costs.

4

Indicates the account from 

which the funds will be taken 

for this cheque. 2

Fill out the cheque just like 

you would a paper cheque.
3

Use the Items tab to itemise

the products and services

you’ve bought with or without

a purchase order.

5
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Writing Cheques
You can write a cheque for any kind of expense that you 
track with QuickBooks expense accounts and for non-stock 
part, service, and other charge items. If you are using stock 
or purchase orders (Premier only), you can write cheques for 
stock part items too.

Note: Before writing a cheque, be sure you read the section “Writing 

cheques versus paying bills” on page 39 to make sure you are using 

the correct payment method.

To write a cheque:

➊ Go to the Banking menu and click Write Cheques.

➋ Click the Bank Account drop-down arrow and then click 
the account from which you want to write the cheque.

➌ Fill in the onscreen cheque as you would a paper 
cheque.

➍ Itemise your expenses (shipping charges, taxes, or other 
expenses not associated with any one item) on the 
Expenses tab.

➎ If you are purchasing items for your stock, enter the 
items on the Items tab.

➏ Save the transaction.

To ! nd and print a single cheque:

➊ Load the blank cheque form into the printer.

➋ Go to the Banking menu and click Write Cheques.

➌ Click the Find button and search for the cheque you 
want to print.

➍ Double-click to view the cheque you want to print.

➎ Click Print.

➏ In the Print Cheques window, choose the options you 
want and click Print.

Note: To learn how to print multiple cheques at the same time, 

refer to the in-product Help.

You should not use the 

Write Cheques window to 

write a payroll payment, 

pay your payroll liabilities, 

pay VAT, or pay bills you’ve 

already entered in the Pay 

Bills window.

Paying employees

Refer to page 89 for 

instructions on paying 

employees.

Did You Know?



86

Money Out  |  Issuing Credits or Refunds

Credit Note

Describe the reason for the 

return.
5

 

Select the template you

want to use, or create your 

own.

x

Previous Next

SOLD TO SHIP TO

P.0 NO. 

ITEM DESCRIPTION QUANTITY RATE AMOUNT VAT

Tax Date Credit No.

Spelling History Journal Use Credit To 

Custom Credit Note

Template Print Preview

Clear

S

Total VAT

Save & Close

Type a help question Ask How Do I?Create Credit Memos/Refunds 

Credit Note

Customer:Job

15/12/2008

Baker, Chris
1234 Orchid Road
Twyford, Reading, Bershire
RG10 9BF

Labor 5 70.00 350.00 

61.25 0.00

350.00 Total

S

Baker, Chris

Customer
Message

To be printed Customer VAT code e Remaining Credit    350.00 

92 

Save & New

 

The listed amount will be 
credited to your account

Memo

Job took 5 fewer hours than billed 
Enter the name of the 

returned item here.
2

Select to print a copy for the 

customer.
7

3
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Key Term
Issuing Credits or Refunds
Use a credit note to record a credit when a customer returns 
items and you’ve already recorded an invoice, customer 
payment, or sales receipt. You can also use a credit note for 
an overpayment.

To enter a credit note or record a return:

➊ Go to the Customers menu and click Create Credit 
Notes/Refunds.

➋ In the Customer:Job field, click the customer and job for 
which you are creating the credit note or refund cheque.

Note: If you have created more than one job for the customer, be 

sure to assign the credit note to the correct job. You can apply the 

credit note only to the same job for which it was created.

➌ Click the Template drop-down arrow and then click a 
template.

➍ Enter the items being returned in the line item area.

➎  Describe the reason for the credit and enter the quality 
and rate, if applicable.

➏ (Optional) Enter a memo for this transaction.

Note: The memo does not print on the credit note, but it does 

appear in the Accounts Receivable register and in the customer 

register.

➐ Indicate whether you want to print the credit note to the 
customer.

➑ Save the credit note.

➒ In the Available Credit window, choose how to use the 
credit. You can:

• Retain as an available credit

• Give a refund

• Apply it to an invoice

Note: QuickBooks enters a negative amount in your Accounts 

Receivable register for the credit note.

Credit note

A document that noti" es 

a customer that you have 

reduced the customer’s 

balance (for example, when 

a customer cancels a sale, 

returns something, or 

overpays).

Key Term
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Money Out  |  Paying Employees

Enter Hours and Select Employees to Pay

Review and Create Payroll Payments

QuickBooks creates a 

payroll payment for each 

ticked employee.

Specify a payment, date, and

pay period for the payroll

payments you create.

QuickBooks records the

payroll payments in this bank

account.

Review payroll payments and 

enter hours worked, sick or 

holiday time, commissions, or 

other variations from pay 

period to pay period by 

clicking the employee’s name.

Review payroll payments and 

enter hours worked, sick or 

holiday time, commissions, or 

other variations from pay 

period to pay period by clicking 

the employee’s name.

Choose whether payroll 

payments should be printed

from QuickBooks or written 

later by hand.
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Paying Employees
Your employees can be paid weekly, fortnightly, four weekly 
or monthly, and you can create their payments using 
cash, cheques or BACS. The employee’s tax and NICs are 
calculated automatically using the tax code and NI letter 
that you entered in the employee’s pro" le.

Note: Before you begin paying your employees, ensure that your 

payroll is set up completely and correctly in QuickBooks. For details, go 

to the Employees menu and click Payroll Learning Centre.

The following steps create payments for unscheduled 
payroll. If you want to use payroll schedules, see the sidebar 
to the right.

To create payroll payments

➊ Click the Payroll icon.

➋ In the Pay Employees section on the right side of the 
Payroll Centre, click the Unscheduled Payroll button.

➌ Select the employees or employees you’re creating the 
payroll payment for.

➍ Verify that the Payment Date and Pay Period Ends date 
are correct.

➎ Click the Bank Account drop-down arrow to choose the 
account that QuickBooks uses to record this transaction.

➏ Review the payroll payment information in the Review 
and Create Payroll Payments window.

➐ In turn, click each employee’s name to open the Review 
or Change Payroll payment window. Make any necessary 
changes and click Done.

➑ Click Continue.

➒ Click Create Payroll Payments.

❿ In the Confirmation and Next Steps window that appears, 
click Print Cheques or Print Payslips, or both.

⓫ After printing your payroll payments or payslips, click 
Close.

89

Using Payroll Schedules

A payroll schedule de" nes 

when you should run 

your payroll so that you 

can pay employees on 

their pay day. You can 

use payroll schedules to 

group together employees 

in whichever way makes 

the most sense for you to 

your business. However, 

all employees grouped in 

the same payroll schedule 

must have the same 

pay frequency (weekly, 

fortnightly, monthly, and 

so on).

If you want to use payroll 

schedules, click the Payroll 

Centre icon. From the 

Pay Employees section, 

click Set Up Your Payroll 

Schedule. After you create 

a new payroll schedule, you 

can assign employees to it.

To run a scheduled payroll, 

go to the Employees menu, 

click Pay Employees, and 

then click Scheduled 

Payroll. In the Pay 

Employees section, click to 

select the payroll schedule 

you want to run and then 

click Start Scheduled 

Payroll.

For more information, see 

the in-product Help.

Did You Know
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x

Reports Reports 

Report Centre

Customers & Receivables 

Customers & Receivables 
Find out how much money your customers owe and when it is due. Company & Financial 

Sales 

Jobs,  T ime & Mileage 

Suppliers & Payables

Purchases 

Stock

Employees & Payroll 

Banking 

Accountant &  T axe s 

Budgets & Forecasts 

List 

Memorised Preferences Learning 

A/R Ageing (what my customers owe me and what is overdue)

Customer Balance 

Summary 

Detail 

Accounts Receivable Graph 

Summary 

Open Invoices 

Collections 

Detail 

Unbilled Costs by Job 

T ransaction List by Custome r 

How much does each customer owe? How much of each 
custome r ’ s balance is overdue?  More.. . 

Which invoices or statement charges are due and
overdue?  More... 

For the total amount owed by my customers, what 
proportion of that amount is overdue? (i.e., show me a 
graph of the information in the A/R aging summary 
report.)  More... 

Which invoices or statement charges haven’t been paid 
and when are they due?  More... 

Which customers are overdue, how much do they owe, 
and what are their phone numbers?  More... 

How much does each customer owe?  More... 

What payments and invoices make up each custome r ’ s 
current balance?  More... 

What job-related expenses haven’t been charged to 
customers?  More... 

What transactions has my company had with each 
customer?  More... 

SA
M
PL
E

A/R Aging Detail 

T yp e 

Current 

T otal Curren t 

1 - 30 

T otal 1 - 3 0 

> 30 

T otal > 3 0 

T O T A L 

Invoice 

Invoice 

Invoice 

Date Name T erm s Due Date Balance 

25/12/2000

01/11/2000

01/08/2000

25/12/2000

01/12/2000

31/08/2000

488.30 

488.30 

Net 30 

Net 30 

Net 30 

Cook, Brian 

Pretell Estates 

Pretell Estates 

5.65 

5.65 

990.00 

990.00 

1,483.95 

Report Center

Click More… for details 

about content, dates, and 

customisation.
3

Click the thumbnail report

icon to view a sample of 

a report.

3

 

Report choices displayed in

the window are based on the

category you choose.
2

View detailed Help topics to

learn how to use and modify 

reports.
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What transactions has my company had with each 

Using Reports to see how your business 
is doing
One of QuickBooks’ most robust features is its ability to 
generate data-rich reports about your business. Everything 
you enter in QuickBooks can be found and generated into a 
report.

QuickBooks comes with dozens of prepared reports that 
you can run. You can use the Report Centre to learn about 
QuickBooks reports and locate the ones that contain the 
information you need. Once you’ve found a report, you can 
change its date range, customise the way it looks, print a 
copy of it, export it to Microsoft Excel, or display it on your 
screen. 

To ! nd and display the right report:

➊ Click the Report Centre icon at the top of the 
QuickBooks window. 

➋ Click a report category from the list on the left. Reports 
for the selected category are displayed on the right.

➌ From the report list, you can view a thumbnail picture 
of the report by moving your mouse over the thumbnail 
icon  . To learn more about a specific report, click the 
More... link to learn about the data and specific ways to 
customise the report.

➍ When you find the report you need, click its name to 
view the report.

Tip  In addition to the powerful reports available in 
the Report Centre, you can also use the QuickBooks 
Centres to get a quick snapshot of how your business 
is doing and the status of your relationships with your 
customers, suppliers, and employees. For example, 
from the Centres you can easily see all of your 
unpaid bills, all of the invoices that your customers 
haven’t paid, and the detailed history of each of 
your customers and suppliers. For more information 
about the QuickBooks Centres, refer to “QuickBooks 
Centres” on page 29 or the in-product Help.

The Report Centre includes 

its own Learning Centre, 

where you can " nd detailed 

information about how to 

run, modify, and manage 

reports. You can view the 

Report Centre Learning 

Centre by clicking the 

Learning Centre link in 

the top-right corner of the 

Report Centre.

91

Did You Know
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How to Use Reports to Find the Information You Want

The QuickBooks Report Centre describes all the available reports. Here are 10 common 
questions that people ask and the QuickBooks report you can use to " nd the answer.

Item Type Purpose

How much money did my company make or lose over a speci" c period 
of time?

Pro! t & Loss Standard
(In Company & 
Financial)

Which invoices or statement charges haven’t been paid and when are 
they due?

Open Invoices
(In Customers & 
Receivables)

How much does my company owe each supplier and are any payments 
overdue?

Unpaid Bills Detail
(In Suppliers & 
Payables)

What is the value of my company (its assets, liabilities, and equity), 
and where can I see the total balance for each type of account?

Balance Sheets
(In Company & 
Financial)

What is the recent activity in all my company’s accounts, with 
beginning and ending balances for each account?

General Ledger
(In Accountant & 
Taxes)

What are the total sales for each customer and job?
Sales by Customer 
Summary
(In Sales)

Which items and/or services bring in the most/least income?
Sales by Item 
Summary
(In Sales)

What are my company’s total expenses for each supplier?

Expenses by Supplier 
Summary
(In Company & 
Financial)

Where is the information I need for my income tax forms?

Income Tax Summary
Income Tax Detail
(In Accountant & 
Taxes)

For my company’s total sales, how much is taxable, at what rate, and 
how much VAT is currently due to be paid?

VAT Liability
(In Suppliers & 
Payables)



93

Managing Your Business

Memorising a report for reuse
Whenever you change the settings for a report (modify it), you can memorise the report with 
the new settings and save it in the Memorised Report List. Then, when you want to create a 
similar report, you can click the Memorised Report List to " nd it.

Note: QuickBooks memorises the report settings, not the data in the report. When you display a memorised 

report, it applies the settings you memorised, but displays the latest data. For example, if the report date 

is set for the period Last Month and you memorise the report in September but recall it in December, the 

recalled report will have data for November, not August.

To memorise a report:

➊ Click the Report Centre icon at the top of the QuickBooks window. 

➋ Open the report you want to modify and save. 

➌ After you have customised a report, click Memorise at the top of the report.

➍ If you have changed an existing memorised report, indicate whether you want 
QuickBooks to replace the earlier report (under the same name) or create a new 
memorised report (under a new name).

➎ In the Memorise Report window, enter a title for the report.

➏ If you want to assign the report to a memorised report group, choose Save in Memorised 
Report Group and choose the group from the drop-down list. (You must already have the 
group set up on your Memorised Report List. You cannot create a new group here.)

➐ Click OK.

Tip  When you create a report, you can change the way it looks (reformat it). You can 
change the fonts, change the header and footer, and resize the columns. 

You can also move and sort the data that the report contains. For example, you can 
add or delete columns, sort by columns, move columns, change how numbers display, 
change how transactions sort, and change the subtotal groupings.

For more information about how to modify the look and content for a report, refer to 
the in-product Help.
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Other QuickBooks Services to help you manage your business
QuickBooks Business Services enable you to streamline management of your business and 
automate essential business activities. QuickBooks Business Services offer easy-to-use, 
tightly integrated solutions that will enable you to manage your business ef" ciently and with 
con" dence.

Intuit Business Services and software include:

• QuickBooks Merchant Account Service

• QuickBooks Payroll Service

• Business Credit Reports

• Technical Support Plan

To learn more about these business solutions, go to the Help menu and click Add 
QuickBooks Services.
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QuickBooks Solutions Marketplace
QuickBooks Solutions Marketplace can help you run your business more ef" ciently by 
providing quick access to information about more than 400 industry-speci" c software 
solutions that work seamlessly with QuickBooks.

Created by independent developers with " rst-hand knowledge of your industry, this software 
helps eliminate double data entry, streamlines business operations, increases productivity 
and helps save you time. Working more ef" ciently enables you to focus on more important 
issues, like running and growing your business. 

To learn more about QuickBooks Solutions Marketplace, go to www.marketplace.intuit.com.

A sampling of industry and task-based software solutions found within QuickBooks Solutions 
Marketplace include:

• Construction. Improve how you manage your contracting jobs and learn how you can earn 
more money from each job. Solutions are available to help solve your estimating, job 
tracking needs and more.

• Manufacturing and Wholesale. Need to improve your stock tracking capability? Want better 
control over your shop % oor? Find solutions that address key tasks, including planning and 
tracking, customer management, and EDI.

• Professional Services. Strengthen management of your " rm, including better control over 
your client information and time tracking capability.

• Retail. Increase the ef" ciency of your retail business and spend more time with your 
customers through improved point of sale transactions, customer management, and 
e-commerce selling efforts.

• Wholesale and Distribution. Learn how you can better control your stock tracking capability. 
Need to improve your order management process? Find software that meets your special 
needs including EDI, route delivery automation, and pricing.
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What’s New in QuickBooks 2008

Intuit listens to thousands of customer suggestions to improve the quality and performance 
of our software. This chapter highlights some of the new features available in QuickBooks 
2008. For more information about any of these features, refer to the in-product Help.

Note: If you would like to submit a product suggestion, go to the Help menu, click Send Feedback Online, 

and then click Product Suggestion.

QuickBooks Pro Edition
The 2008 release of QuickBooks Pro includes these new features and improvements.

Easier QuickBooks startup interview and company setup

When you " rst use QuickBooks, you will create your company " le by answering simple 
questions in a step-by-step interview. This EasyStep Interview has been streamlined and 
optimised to con" gure QuickBooks to work in the way you operate your business. It uses 
clear and simple language, but if there’s ever a term or concept you don’t understand, Help 
is available.

QuickBooks now provides a streamlined Chart of Accounts for different industry types, and 
you can customise any account to meet the speci" c needs of your business. Each time you 
create a new account, QuickBooks helps you set it up correctly.

Simpli! ed bill paying

Several improvements have been made to the windows associated with “money out” 
activities, like paying your bills.

• Automatic account selection and auto population save you time and result in fewer 
clerical errors. If you consistently use the same expense account for a particular supplier, 
QuickBooks now automatically selects that account when you specify that supplier and 
automatically populates the account when you enter the bill. You can also set up default 
links between speci" c suppliers and accounts.

• The Pay Bills con! rmation window displays a list of the bills you’ve successfully paid and 
alerts you of any bills that didn’t go through.

Improved forms customisation 

The windows for creating high-quality forms has been redesigned and now provides 
immediate access to most common customisation options. It also provides a real-time 
preview and easy access to a print preview. Over time, you can further customise and 
enhance your forms to re% ect the unique needs and style of your business.

Improved ! le management 

QuickBooks 2008 " le backup and " le restore capabilities have been centralised and 
improved. By making it easier to protect and retrieve your valuable business records, 
QuickBooks helps ensure against data loss in case of hardware failure or a natural disaster.
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Improved Home Page

The Home Page and navigation bar has been greatly improved to be friendlier, faster, and 
more intuitive. The Customer Centre, Supplier Centre, and Employee Centre have also 
been improved. It is now easier for you to see how and when to use the many features of 
QuickBooks.

Securely search QuickBooks with Google Desktop

Search in QuickBooks uses Google Desktop technology to quickly " nd your QuickBooks 
data, such as customer, supplier, or " nancial information. You can even extend you search to 
look at other " les on your computer including e-mails, documents, and " les. Simply enter a 
few words or phrases to search for a list of the most likely matches. Once you’ve identi" ed 
the information you want, you can click the link to go directly to the data in QuickBooks or 
to the " le on your desktop. Intuit installs a customised version of Google Desktop to ensure 
your privacy and makes your computer information available only to authorised users on 
your desktop.

Improved cheque printing 

The screens for printing cheques have been enhanced to help ensure that cheques print 
correctly. The default cheque style is Voucher, and the choices are ordered according to 
popularity. QuickBooks 2008 also makes it easier to match the correct data to cheque 
numbers when printing Back to Front and to select individual cheques for reprint.

Improved Payroll

The new Payroll Centre makes using payroll easy. All of your payroll tasks are organised into 
a simple, easy-to-follow work% ow that makes it simple to " gure out what you need to do 
next.

New VAT system

The system for tracking and reporting on VAT has been improved to be faster and more 
% exible.

Cash-based VAT

Users who track VAT on a cash basis can now use the File VAT feature, just like accrual 
based VAT.

Accountant’s Copy 

The new Accountant’s Copy allows improved communication between accountants and their 
clients. Accountants can review, correct and complete their clients’ accounting data while 
their clients continue to operate their businesses. As an accountant works on a copy of a 
client’s historical records, the client can continue to work in the current period of accounting 
data. After completing work, the accountant can add a note and send the changes back to 
the client. The client can read the acccountant’s note, review changes, and import them into 
their ongoing accounting records.

New Features
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Streamlined time and billing 

Improved user interface and work% ow allow you to get your billables (such as hours, 
expenses, mileage, and items) onto invoices more easily. When you create an Invoice for 
a customer with outstanding billables, QuickBooks offers to take you immediately to a 
selection window where you can select which billables to put on the invoice. And whenever 
you’re viewing the invoice, it’s easy to determine if there are billables outstanding by looking 
at the Add Time/Costs… button, which is greyed out when there aren’t any.

QuickBooks Premier Edition
QuickBooks Premier helps you manage your " nances most effectively, with comprehensive 
tools to help achieve better results and meet specialised or more complex needs. 
QuickBooks Premier includes all of the new features and improvements in QuickBooks Pro, 
plus these additional features.

Improved Units of Measure

The Units of Measure feature has been enhanced. You can now create abbreviations for 
measures. QuickBooks also now uses a wizard to help set up of new units of measure, 
automatically calculating values for common units like metres and centimetres.

Audit trail improvements

The always-on audit trail has been improved to include more transaction details and easier-
to-read reports. Preventing and " nding errors is now easier with reporting that presents 
every date an individual transaction has been modi" ed. It also requires anything that’s 
printed to be saved " rst to help prevent theft.

Integration with Outlook 2007

The new Contact Synchronisation tool lets you integrate your customer and supplier list with 
your Microsoft Outlook 2007 contacts. This saves you from having to enter names, address, 
and other contact information and ensures that both QuickBooks and your Outlook contact 
list list the same people
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Frequently Asked Questions

How do I register my copy of QuickBooks?

You can register online or by phone. Go to the Help menu and click Register QuickBooks. 

How do I contact technical support?

To search for solutions online, go to the QuickBooks Support Site at http://www.quickbooks.
co.uk/store/en/quickbooks/support_overview.jsp. You can search the QuickBooks Support 
Knowledge Base or visit the QuickBooks Community and connect with other QuickBooks 
users and experts online.

For installation assistance before you register, call 0845 606 2161 (outside the UK, 
+44 870 609 0601). Hours for customer support are Monday to Friday from 9.00 a.m. to 
5.30 p.m., excluding UK Bank Holidays.

For questions not covered by free support, assistance is available on a fee-per-call basis 
or as part of a QuickBooks Support Plan. To learn more about these paid options, visit 
the QuickBooks Support Web site at http://www.quickbooks.co.uk/store/en/quickbooks/
support_overview.jsp or call 0845 606 2161.

Note:  Support hours may vary occasionally due to system and server maintenance, company events, 

observed statutory holidays, and events beyond our control.

How do I purchase additional user licenses so I can add users to my QuickBooks?

You can add users to your QuickBooks in two ways:

• You can purchase additional copies of QuickBooks in a store or;

• You can buy additional user licenses by phone. 

To add a license to your existing QuickBooks license by phone, go to the Help menu, 
click Manage My License, and then click Buy additional user license. Follow the onscreen 
instructions.

For other QuickBooks purchasing questions, call 0845 606 2161. If you have not set up 
your QuickBooks for multi-user access, please see “Installing and Setting up QuickBooks for 
multi-user environment” on page 11.

How do I download and install an update or patch?

Periodically, Intuit provides updates to QuickBooks that you can download from the Internet. 
These updates can include a maintenance release (also known as a patch), a new feature, 
or a new service. 

To download an update, go to the Help menu and click Update QuickBooks. Follow the 
onscreen instructions.

Note: If you store your company fi le on a fi le server and also installed QuickBooks on that computer (as 

described on page 5), you also need to apply patches and updates to the server.
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How do I move my QuickBooks ! le from one computer to another?

To move QuickBooks company " les from one computer to another, we recommend that you 
use a portable company " le. The portable company " le does not simply copy the data for 
your QuickBooks company; it compresses the data into a smaller " le.

To move your company ! le:

➊ Create a portable company file on the source computer:

a. Go to the File menu and click Save Copy or Backup.
b. Select Portable Company File and then click Next.
c. Choose the drive (hard drive, CD, or Zip® disk) where you want to save the portable 

company " le. You can use the same " le name or enter a new name.
d. Click Save.

➋ Take the media containing your portable company file to the computer to which you want 
to move your company file.

➌ Open the portable company file on the destination computer:

a. Go to the File menu and click Open or Restore Company.
b. Select Restore a portable ! le and then click Next.
c. Browse to select the portable company " le you want to restore, click Open, and then 

click Next.
d. Browse to select and change the location and " le name of the company " le that will be 

created and opened from the portable company " le. If you select an existing company 
" le, it will be overwritten with the data from the portable company " le.

e. Click Save.

How do I remove older or unneeded transactions from my data ! le?

You can use the Clean Up Company Data utility to remove transactions that you no longer 
need to keep detailed records of. You can choose to remove transactions as of a speci" c 
date (for example, all transactions dated on or before 31/12/04). Optionally, you can 
choose to remove unused list items, such as obsolete customers and items.

Before removing the transactions, QuickBooks creates an archive copy of your company " le 
and enters general journal transactions that summarise the transactions being removed.

Note: Cleaning up the data in the company fi le does not reduce the physical size of the company fi le.

How often should I back up or restore my company ! le?

You should back up your QuickBooks company " les daily. Backup copies are important 
insurance—if you should lose data for any reason, you can restore data from your backup 
copy. QuickBooks enables you to back up and restore your data in a number of ways.

To view detailed information about each backup and restore option, refer to the in-product 
Help.

FAQ
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To back up a company ! le:

➊ Go to the File menu and click Save Copy or Backup.

➋ Choose the backup option you want, click Next, and follow the onscreen instructions.

To restore a company ! le:

➊ Go to the File menu and click Open or Restore Company.

➋ Choose the restore option you want, click Next, and follow the onscreen instructions.

What should I do if I forget my password?

If you forget your password or you cannot log on to your company " le because your 
administrator password is not working, you can use the tips below to try to remember the 
password on your own.

Try the following:

• Attempt to log on by entering the login name of Admin and then click OK without typing a 
password.

• Enter your password with the Caps Lock key on and then off. Repeat with the Num Lock 
key on and off.

• Enter password variations, using mixed upper- and lower-case characters.

• Enter the password with a space before or after the actual password.

• Enter the password in a text editor to con" rm that your keyboard is functioning properly.

• Restore a pre-update backup of your " le that does not have the case-sensitive password. 
When you restore this " le, you can set your new administrator password at the end of the 
update process.

If you are still unable to access your " le, contact Customer Support for assistance at 
0845 606 2161 (outside the UK, +44 870 609 0601). A fee may be charged for this service 
depending on the support options of your service plan.

How do I update my payroll to use the latest tax tables?

If you are a QuickBooks Payroll subscriber, you have two options for updating your tax tables. 
You can:

• Go to the Help menu and click Update QuickBooks.

• Turn on the Auto-update preference. When a new tax table is available, it will be 
downloaded automatically and you will be prompted to install.

Payroll updates, which might include compliance enhancements and updated payroll tax 
forms as well as new tax tables, become available throughout the year. We recommend that 
you connect to the payroll service at least every 45 days to make sure you have the most 
current tax table available.

Make sure that you download and install the latest payroll update before you pay employees 
for the " rst time.
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General Key

To start QuickBooks without 
a company " le

Ctrl (while 
opening)

To suppress the desktop 
windows
(at Open Company window)

Alt (while 
opening)

Display product information 
about your QuickBooks 
version

F2

Close active window
Esc or 
Ctrl+F4

Record (when black border 
is around OK, Save and 
Close, Save and New, or 
Record)

Record (always) Ctrl + 

Dates Key

Next day + (plus key)

Previous day - (minus key)

Today T

First day of the Week W

Last day of the weeK K

First day of the Month M

Last day of the montH H

First day of the Year Y

Last day of the yeaR R

Date calendar
Alt + 
(down arrow)

Editing Key

Edit transaction selected in 
register or lift

Ctrl + E

Delete character to right of 
insertion point

Del

Delete character to left of
insertion point

Backspace

Delete line from detail area Ctrl + Del

Insert line in detail area Ctrl + Ins

Cut selected characters
Ctrl + X

Copy selected characters Ctrl + C

Paste cut or copied 
characters

Ctrl + V

Increase cheque or other 
form number by one

+ (plus key)

Decrease cheque or other 
form number by

- (minus key)

Undo changes made in " eld Ctrl + Z

Help Window Key

Display Help in context F1

Go to next Help topic Tab

Go to previous Help topic Shift + Tab 

Display selected topic

Keyboard Shortcuts



112

Activity Key

Copy cheque transaction in 
register

Ctrl + O

Create invoice Ctrl + I

Delete cheque, invoice, 
transaction, or item from list

Ctrl + D

Find transaction Ctrl + F

Go to register of transfer 
account

Ctrl + G

History of A/R or A/P 
transaction

Ctrl + H

Memorise transaction or 
report

Ctrl + M

New invoice, bill, cheque or 
list item in context

Ctrl + N

Open account list Ctrl + A

Open Customer Centre 
(Customers & Job list)

Ctrl + J

Open Help for active window F1

Open list (for current drop-
down menu)

Ctrl + L

Open memorised transaction 
list

Ctrl + T

Open split transaction 
window in register

Ctrl + R

Open transaction journal Ctrl + Y

Paste copied transaction 
in register

Ctrl + V

Print Ctrl + P

QuickReport on transaction 
or list item

Ctrl + Q

QuickZoom on report

Show list Ctrl + S

Use list item Ctrl + U

Write new cheque Ctrl + W

Moving around 
a window

Key

Next " eld Tab

Previous " eld Shift + Tab

Beginning of current " eld Home

End of current " eld End

Line below in detail 
area or 
on report

Down arrow ( )

Line above in detail area 
or on report

Up arrow ( )

Down one screen Page Down

Up one screen Page Up

Next word in " eld Ctrl + 

Previous word in " eld Ctrl + 

First item on list or 
previous month in 
register

Ctrl + Page Up

Last item on list or next 
month in register

Ctrl + Page Down

Close active window Esc or Ctrl + F4


